Maintenance Guide

Applied
Bigspystems

Applied Biosystems

7500/7500 Fast
Real-Time PCR Systems

System Maintenance







Maintenance Guide

Applied Biosystems

7500/7500 Fast
Real-Time PCR Systems

System Maintenance

& Applied
A‘% Bigspystems

Overview

Perform the
Regions of Interest
(ROI) Calibration

Perform the
Background
Calibration and
Optical Calibration

Perform the Dye
Calibration

Verify the
Instrument
Performance

User-Performed
Maintenance




© Copyright 2008, 2010 Applied Biosystems. All rights reserved.

Information in this document is subject to change without notice. Applied Biosystems assumes no responsibility for any errors that may appear in this
document.

APPLIED BIOSYSTEMS DISCLAIMS ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT
NOT LIMITED TO THOSE OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL APPLIED
BIOSYSTEMS BE LIABLE, WHETHER IN CONTRACT, TORT, WARRANTY, OR UNDER ANY STATUTE OR ON ANY OTHER BASIS FOR
SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM
THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

NOTICE TO PURCHASER: Label License

The Applied Biosystems 7500 and 7500 Fast Real-Time PCR Systems are covered by US patents and corresponding claims in their non-US counterparts,
owned by Applied Biosystems. No right is conveyed expressly, by implication, or by estoppel under any other patent claim, such as claims to apparatus, re-
agents, kits, or methods such as 5" nuclease methods. Further information on purchasing licenses may be obtained by contacting the Director of Licensing,
Applied Biosystems, 850 Lincoln Centre Drive, Foster City, California 94404, USA.

TRADEMARKS:

Applera, Applied Biosystems, AB (Design), ABI PRISM, and VIC are registered trademarks, and FAM, JOE, NED, ROX, and TAMRA are trademarks of
Applied Biosystems or its subsidiaries in the U.S. and/or certain other countries.

AmpErase and TagMan are registered trademarks of Roche Molecular Systems, Inc.
SYBR is a registered trademark of Molecular Probes, Inc.
Microsoft and Windows are registered trademarks of Microsoft Corporation.

All other trademarks are the sole property of their respective owners.

Part Number 4387777 Rev. D
06/2010



Contents

Preface .. ....... i i e e vii
HowtoUse ThisGuide ........ ... et vii
How to Obtain More Information .......... ... ... . . .. viii
How to Obtain Support . ... e X
Safety and EMC Compliance Information.............. Xi
Safety Conventions Used in This Document . ....... ... ... ... ... . . .. ... xii
Symbols onInstruments ........... ... e Xiii
Safety LabelsonInstruments . ... ... ... . Xiv
General Instrument Safety .......... ... i e XVi
Chemical Safety .. ... ... e XVii
Chemical Waste Safety ........... . .. i i i Xix
Electrical Safety .. ... ... XX
Physical Hazard Safety ......... ... e e et XX
Biological Hazard Safety ......... ... ... i XXi
Workstation Safety . ......... i e XXi
Safety and Electromagnetic Compatibility (EMC) Standards . . ... .............. XXii
Chapter 1 OVerviewW . ........coiiiiii ittt eannnnnnnns 1
About the 7500/7500 Fast System . ... ... ... . e 2
HowtoUse This Guide . ..... .. . ... e e 4
Recommended Maintenance Schedule .. ....... ... .. ... . . . i i 5
Maintain the Computer Hard Drive(s) . . . . .. oo oo e 6
Archive and Back Up EDS Files ... ... e e e e e 6

Chapter 2 Perform the Regions of Interest (ROI) Calibration.... 7

OV IBW . oo e e e 8
Prepare the ROI Calibration Plate .......... ... ... ... . . .. 9
Perform the Calibration . .......... ... . . i 12
Perform an Automated ROl Calibration ................... ... ... ....... 12
Perform a Manual ROl Calibration .. ........ ... ... ... ... .. ... ... ... 13
Troubleshoot the ROI Calibration .. ............ ... i i 17

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide iii



Chapter 3 Perform the Background Calibration and Optical

Calibration. . ......... ... . it 19

Perform the Background Calibration .................. ... .. . e .. 20

Prepare the Background CalibrationPlate . . . ...... ... ... ... ... ... ... 21

Perform the Background Calibration ................ ... ... ........... 23

Perform the Optical Calibration ....... ... ... . . . . .. 25

Prepare the Calibration Plate ............. ... .. . 25

Perform the Optical Calibration ........... ... ... . . . . 28

Troubleshoot the Background Calibration .............. ... ... ............ 30

Chapter 4  Perform the Dye Calibration. . ... ................ 31
OV IV BW . L oo e 32

Prepare the Dye Calibration Plates . ............. .. . i 35

Perform the Dye Calibration .. ........ ... . . . e 36

Troubleshoot the Dye Calibration .............. ... ... ... 43

Chapter 5  Verify the Instrument Performance ............... 45
VIV BW . . oo e 46

Set Upthe Experiment . ... ... et e e 48

Run the Experiment .. ... ... e 49

Analyze the Experiment ... ... . e 51

Troubleshoot the RNase P Experiment ... ... ... . . . . . . .. 54

Chapter 6 User-Performed Maintenance ................... 55
Monitor the 7500/7500 Fast System . . . ... ..o i 56

View the Instrument Log . . . .. ..o 56

Monitor the Instrument Status . ........ ... .. 57

Monitor the Lamp Status . ... ... 58

Decontaminate the Sample Block ......... ... .. .. .. . . . i 59

Replace the Halogen Lamp ... ... i e 63

Replace the Instrument Fuses . .......... .. . i 66

Update the Windows Operating System . .......... ... .. .. 67

Update the 7500 Software . ........ ...t i e 68

Appendix A Store, Move, and Install the 7500/7500 Fast System ... 69

Store the 7500/7500 Fast System . ... . e i 70
Move the 7500/7500 Fast System . ....... ... 71
Set Up the 7500/7500 Fast System .............. .. i 73

iv Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Vi

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Preface

How to Use This Guide

Purpose of This
Guide

Audience

Assumptions

Text Conventions

User Attention
Words

The Applied Biosystems 7500/7500 Fast Real-Time PCR System Guide provides the
information you need to maintain your Applied Biosystems 7500/7500 Fast Real-Time
PCR System. This manual is designed to supplement the:

» Applied Biosystems 7500/7500 Fast Real-Time PCR System Site Preparation Guide
» Applied Biosystems 7500/7500 Fast Real-Time PCR System Computer Setup Guide

This guide is intended for novice and experienced 7500/7500 Fast system users who
need to maintain their system.

This guide assumes that your 7500/7500 Fast system has been installed by an
Applied Biosystems technical representative and that you:

* Are familiar with the Microsoft® Windows® operating system.
* Understand general techniques for preparing and handling DNA samples.

» Have a general understanding of hard drives and data storage, file transfers, and
copying and pasting.

This guide uses the following conventions:
* Bold text indicates user action. For example:
Type 0, then press Enter for each of the remaining fields.

 [talic text indicates new or important words and is also used for emphasis.
For example:

Before analyzing, always prepare fresh matrix.

* A right arrow symbol ( » ) separates successive commands you select from a
drop-down or shortcut menu. For example:

Select File » Open » Spot Set.
Right-click the sample row, then select View Filter » View All Runs.

Two user attention words appear in Applied Biosystems user documentation. Each word
implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide vii



Preface
How to Obtain More Information

Examples of the user attention words appear below:

Note: The Calibrate function is also available in the Control Console.

IMPORTANT! To verify your client connection to the database, you need a valid user ID
and password.

Safety Alert

Safety alert words also appear in user documentation. For more information, see “Safety

Words

Alert Words” on page xii.

How to Obtain More Information

Related The following related documents are shipped with the 7500/7500 Fast system:

Documentation

viii

Guide Purpose and Audience PN
Applied Biosystems 7500/7500 Fast Explains how to perform experiments on the 7500/7500 Fast 4387784
Real-Time PCR System Getting Started system. Each Getting Started Guide functions as both:
Guide for Genotyping Experiments e Tutorial, using example experiment data provided with the
Applied Biosystems 7500/7500 Fast "S*p]'?“ed B'?gggtgmfs 7500/7500 Fast Real-Time PCR 4387785
Real-Time PCR System Getting Started oftware ( oftware).
Guide for Presence/Absence Experiments | ® Guide for your own experiments.
. . Intended for laboratory staff and principal investigators who
Applied Biosystems 7500/7500 Fast . : 4387783
Real-Time PCR System Getting Started perform experiments using the 7500/7500 Fast system.
Guide for Relative Standard Curve and
Comparative Cy Experiments
Applied Biosystems 7500/7500 Fast 4387779
Real-Time PCR System Getting Started
Guide for Standard Curve Experiments
Applied Biosystems 7500/7500 Fast Explains how to install and maintain the 7500/7500 Fast system. | 4387777
gi?cl]_enme PCR System Maintenance Intended for laboratory staff responsible for the installation and
maintenance of the 7500/7500 Fast system.
Applied Biosystems 7500/7500 Fast 4387778
Real-Time PCR System Computer Setup
Guide
Applied Biosystems 7500/7500 Fast Provides information about the reagents you can use on the 4387787
Real-Time PCR System Reagent Guide 7500/7500 Fast system, including:
¢ An introduction to TagMan® and SYBR® Green reagents
e Descriptions and design guidelines for the following
experiment types:
— Quantitation experiments
— Genotyping experiments
— Presence/absence experiments
Intended for laboratory staff and principal investigators who
perform experiments using the 7500/7500 Fast system.
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Guide Purpose and Audience PN
Applied Biosystems 7500/7500 Fast Explains how to prepare your site to receive and install the 4387776
Real-Time PCR System Site Preparation 7500/7500 Fast system.
Guide Intended for personnel who schedule, manage, and perform the
tasks required to prepare your site for installation of the
7500/7500 Fast system.
Applied Biosystems 7500/7500 Fast Explains how to use the 7500 Software to: NA

Real-Time PCR Software v2.0 Help e Set up, run, and analyze experiments using the 7500/7500

Fast system.
e Monitor a networked 7500/7500 Fast instrument.
e Calibrate a 7500/7500 Fast instrument.

e Verify the performance of a 7500/7500 Fast instrument with
an RNase P run.

Intended for:

e Laboratory staff and principal investigators who perform
experiments using the 7500/7500 Fast system.

e Laboratory staff responsible for the installation and
maintenance of the 7500/7500 Fast system.

Note: To open the user documentation included on the Documentation CD, use the
Adobe® Acrobat® Reader® software available from www.adobe.com.

Note: For additional documentation, see “How to Obtain Support” on page x.

Obtaining The 7500 software has a Help system that describes how to use each feature of the user
Information from interface. Access the Help system by doing one of the following:

the Help System * Click @ in the toolbar of the 7500 software window
+ Select Help » 7500 Software Help
e Press F1

You can use the Help system to find topics of interest by:
» Reviewing the table of contents
» Searching for a specific topic

* Searching an alphabetized index

You can also access PDF versions of all documents in the Applied Biosystems
7500/7500 Fast Real-Time PCR System document set from the Help system.
Send Us Your Applied Biosystems welcomes your comments and suggestions for improving its user

Comments documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to www.appliedbiosystems.com, then click the link
for Support. (See “How to Obtain Support” below).
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How to Obtain Support

How to Obtain Support

For the latest services and support information for all locations, go to
www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:

Search through frequently asked questions (FAQs)
Submit a question directly to Technical Support

Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

Download PDF documents
Obtain information about customer training

Download software updates and patches

In addition, the Support page provides access to worldwide telephone and fax numbers
to contact Applied Biosystems Technical Support and Sales facilities.
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Safety and
EMC Compliance Information

This section includes the following topics:

Safety Conventions Used in This Document . ............................ xii
Symbols on InStruments. . . .. ... ..ttt e xiil
Safety Labels on Instruments. .. .......... ... .. ... Xiv
General Instrument Safety .. ... ... . . XVi
Chemical Safety. .. ... i e Xvii
Chemical Waste Safety. ........ ..o e XiX
Electrical Safety . ... ..ot i e e e XX
Physical Hazard Safety. ...........c i XX
Biological Hazard Safety . ......... ... . i XX1
Workstation Safety. . ... XX1
Safety and Electromagnetic Compatibility (EMC) Standards............... xxii
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Safety and EMC Compliance Information
Safety Conventions Used in This Document

Safety Conventions Used in This Document

Xii

Safety Alert
Words

Four safety alert words appear in Applied Biosystems user documentation at points in
the document where you need to be aware of relevant hazards. Each alert
word—-IMPORTANT, CAUTION, WARNING, DANGER-implies a particular level of
observation or action, as defined below:

Definitions

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

A (O.\I[e]\] — Indicates a potentially hazardous situation that, if not avoided, may

result in minor or moderate injury. It may also be used to alert against unsafe practices.

A \WLGIIINed — Indicates a potentially hazardous situation that, if not avoided,

could result in death or serious injury.

A prNeldi] — Indicates an imminently hazardous situation that, if not avoided,

will result in death or serious injury. This signal word is to be limited to the most extreme
situations.

Except for IMPORTANTS, each safety alert word in an Applied Biosystems document
appears with an open triangle figure that contains a hazard symbol. These hazard
symbols are identical to the hazard icons that are affixed to Applied Biosystems
instruments (see “Safety Symbols™ on page xiii).

Examples

The following examples show the use of safety alert words:

IMPORTANT! Wear powder-free gloves when you handle the halogen lamp.

A ({0l The lamp is extremely hot. Do not touch the lamp until it has cooled to

room temperature.

A WWLGININe] CHEMICAL HAZARD. Ethanol is a flammable liquid and vapor.

Exposure causes eye, skin, and respiratory tract irritation and may cause central nervous
system depression and liver damage. Read the MSDS, and follow the handling instructions.
Wear appropriate protective eyewear, clothing, and gloves.

A PL[e]1338 ELECTRICAL HAZARD. Failure to ground the instrument properly

can lead to an electrical shock. Ground the instrument according to the provided instructions.
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Safety and EMC Compliance Information

Symbols on Instruments

Electrical The following table describes the electrical symbols that may be displayed on
Symbols on  Applied Biosystems instruments.
Instruments
Symbol Description Symbol Description
Indicates the On position of the I Indicates a terminal that may be
main power switch. pr connected to the signal ground
= reference of another instrument.
This is not a protected ground
terminal.
Indicates the Off position of the Indicates a protective grounding
main power switch. terminal that must be connected
to earth ground before any other
electrical connections are made
to the instrument.
Indicates a standby switch by Indicates a terminal that can
l which the instrument is switched —~ receive or supply alternating
on to the Standby condition. current or voltage.
Hazardous voltage may be
present if this switch is on
standby.
Indicates the On/Off position of a - Indicates a terminal that can
push-push main power switch. e receive or supply alternating or
direct current or voltage.
Safety Symbols The following table describes the safety symbols that may be displayed on

Applied Biosystems instruments. Each symbol may appear by itself or in combination
with text that explains the relevant hazard (see “Safety Labels on Instruments” on

page xiv). These safety symbols may also appear next to DANGERS, WARNINGS, and
CAUTIONS that occur in the text of this and other product-support documents.

Description

Indicates that you should consult the manual for further information and to
proceed with appropriate caution.

Indicates the presence of an electrical shock hazard and to proceed with
appropriate caution.

Indicates the presence of a hot surface or other high-temperature hazard and
to proceed with appropriate caution.

Indicates the presence of a laser inside the instrument and to proceed with
appropriate caution.

Indicates the presence of moving parts and to proceed with appropriate
caution.

a4
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Safety Labels on Instruments

Environmental The following symbol applies to all Applied Biosystems electrical and electronic

Symbols on  products placed on the European market after August 13, 2005.
Instruments
Symbol Description
Do not dispose of this product as unsorted municipal waste. Follow local
municipal waste ordinances for proper disposal provisions to reduce the
T, environmental impact of waste electrical and electronic equipment (WEEE).
\ N I European Union customers:
Call your local Applied Biosystems Customer Service office for equipment
—@ pick-up and recycling. See http://www.appliedbiosystems.com for a list of
customer service offices in the European Union.
[

Safety Labels on Instruments

The following CAUTION, WARNING, and DANGER statements may be displayed on
Applied Biosystems instruments in combination with the safety symbols described in the
preceding section.

Xiv

English

Francais

CAUTION Hazardous chemicals. Read the
Material Safety Data Sheets (MSDSs) before
handling.

ATTENTION Produits chimiques dangeureux.
Lire les fiches techniques de sdreté de
matériels avant la manipulation des produits.

CAUTION Hazardous waste. Refer to
MSDS(s) and local regulations for handling
and disposal.

ATTENTION Déchets dangereux. Lire les
fiches techniques de sireté de matériels et la
régulation locale associées a la manipulation
et I'élimination des déchets.

WARNING Hot lamp.

AVERTISSEMENT Lampe brilante.

WARNING Hot. Replace lamp with an
Applied Biosystems lamp.

CAUTION Hot surface.

AVERTISSEMENT Composants br(lants.
Remplacer la lampe par une lampe
Applied Biosystems.

ATTENTION Surface brilante.

DANGER High voltage.

DANGER Haute tension.

WARNING To reduce the chance of electrical
shock, do not remove covers that require tool
access. No user-serviceable parts are inside.
Refer servicing to Applied Biosystems
qualified service personnel.

AVERTISSEMENT Pour éviter les risques
d'électrocution, ne pas retirer les capots dont
I'ouverture nécessite I'utilisation d'outils.
L’instrument ne contient aucune piéce
réparable par I’ utilisateur. Toute intervention
doit étre effectuée par le personnel de service
qualifié de Applied Biosystems.

CAUTION Moving parts.

ATTENTION Parties mobiles.

WARNING This instrument is designed for
12V, 75W Halogen lamps only.

AVERTISSEMENT Cet instrument est concu
pour des lampes d'halogéne de 12V et 75W
seulement.
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Safety Labels on Instruments

Locations of The Applied Biosystems 7500/7500 Fast Real-Time PCR System contains warnings at
Warnings  the locations shown below.
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General Instrument Safety

General Instrument Safety

AWARNING PHYSICAL INJURY HAZARD. Use this product only as

specified in this document. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Moving and A (.\1[e){] PHYSICAL INJURY HAZARD. The instrument is to be moved

Lifting the and positioned only by the personnel or vendor specified in the applicable site
Instrument preparation guide. If you decide to lift or move the instrument after it has been installed,
do not attempt to lift or move the instrument without the assistance of others, the use of
appropriate moving equipment, and proper lifting techniques. Improper lifting can cause
painful and permanent back injury. Depending on the weight, moving or lifting an
instrument may require two or more persons.

Moving and AWARNING Do not attempt to lift or move the computer or the monitor without

Lifting  the assistance of others. Depending on the weight of the computer and/or the monitor,
Stand-Alone moving them may require two or more people.

Computers and

Monitors

Things to consider before lifting the computer and/or the monitor:

» Make sure that you have a secure, comfortable grip on the computer or the monitor
when lifting.

» Make sure that the path from where the object is to where it is being moved is clear
of obstructions.

* Do not lift an object and twist your torso at the same time.

» Keep your spine in a good neutral position while lifting with your legs.

» Participants should coordinate lift and move intentions with each other before
lifting and carrying.

* Instead of lifting the object from the packing box, carefully tilt the box on its side
and hold it stationary while someone slides the contents out of the box.

Operating the Ensure that anyone who operates the instrument has:

Instrument * Received instructions in both general safety practices for laboratories and specific

safety practices for the instrument.

* Read and understood all applicable Material Safety Data Sheets (MSDSs). See
“About MSDSs” on page xvii.

AWARNING PHYSICAL INJURY HAZARD. Use this instrument as specified

by Applied Biosystems. Using this instrument in a manner not specified by
Applied Biosystems may result in personal injury or damage to the instrument.

Cleaning or A (oZ\U[e)\] Before using a cleaning or decontamination method other than those

Decontaminating recommended by the manufacturer, verify with the manufacturer that the proposed
the Instrument method will not damage the equipment.
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Chemical Safety

Chemical Safety

Chemical Hazard AWARNING CHEMICAL HAZARD. Before handling any chemicals, refer to

Warning the Material Safety Data Sheet (MSDS) provided by the manufacturer, and observe all
relevant precautions.

A LGN el CHEMICAL HAZARD. All chemicals in the instrument, including

liquid in the lines, are potentially hazardous. Always determine what chemicals have
been used in the instrument before changing reagents or instrument components. Wear
appropriate eyewear, protective clothing, and gloves when working on the instrument.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste

in a glass container because of the risk of breaking or shattering. Reagent and waste
bottles can crack and leak. Each waste bottle should be secured in a low-density
polyethylene safety container with the cover fastened and the handles locked in the
upright position. Wear appropriate eyewear, clothing, and gloves when handling reagent
and waste bottles.

About MSDSs Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining MSDSs The MSDS for any chemical supplied by Applied Biosystems is available to you free
24 hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:
* Open — To view the document
* Print Target — To print the document
» Save Target As — To download a PDF version of the document to a destination
that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.
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Chemical Safety

Chemical Safety To minimize the hazards of chemicals:

Xviii

Guidelines

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xvii.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended on the MSDS.

Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.
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Chemical Waste Safety

Chemical Waste Safety

Chemical Waste A (X1[e]f] HAZARDOUS WASTE. Refer to Material Safety Data Sheets and
Hazard local regulations for handling and disposal.

AWARNING CHEMICAL WASTE HAZARD. Wastes produced by Applied

Biosystems instruments are potentially hazardous and can cause injury, illness, or death.

AWARNING CHEMICAL STORAGE HAZARD. Never collect or store waste in a

glass container because of the risk of breaking or shattering. Reagent and waste bottles can
crack and leak. Each waste bottle should be secured in a low-density polyethylene safety
container with the cover fastened and the handles locked in the upright position. Wear
appropriate eyewear, clothing, and gloves when handling reagent and waste bottles.

Chemical Waste To minimize the hazards of chemical waste:

Safety Guidelines .

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.
After emptying the waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

Waste Disposal If potentially hazardous waste is generated when you operate the instrument, you must:

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.
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Electrical Safety

Electrical Safety

Fuses

Power

Overvoltage
Rating

A PEW[e]33] ELECTRICAL SHOCK HAZARD. Severe electrical shock can
result from operating the Applied Biosystems 7500/7500 Fast Real-Time PCR System
without its instrument panels in place. Do not remove instrument panels. High-voltage
contacts are exposed when instrument panels are removed from the instrument.

AWARNING FIRE HAZARD. Improper fuses or high-voltage supply can
damage the instrument wiring system and cause a fire. Before turning on the instrument,
verify that the fuses are properly installed and that the instrument voltage matches the
power supply in your laboratory.

AWARNING FIRE HAZARD. For continued protection against the risk of fire,
replace fuses only with fuses of the type and rating specified for the instrument.

A pEWelAi] ELECTRICAL HAZARD. Grounding circuit continuity is vital for

the safe operation of equipment. Never operate equipment with the grounding conductor
disconnected.

A pNel35] ELECTRICAL HAZARD. Use properly configured and approved
line cords for the voltage supply in your facility.

A PLW[e]33] ELECTRICAL HAZARD. Plug the system into a properly
grounded receptacle with adequate current capacity.

The Applied Biosystems 7500/7500 Fast Real-Time PCR System has an installation
(overvoltage) category of II, and is classified as portable equipment.

Physical Hazard Safety

Moving Parts

XX

éWARNING PHYSICAL INJURY HAZARD. Moving parts can crush and cut.

Keep hands clear of moving parts while operating the instrument. Disconnect power
before servicing the instrument.
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Biological Hazard Safety

Biological Hazard Safety

General &WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

Biohazard infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
conducted in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines published in Biosafety
in Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29 CFR
§1910.1030; www.access.gpo.gov/ nara/cfr/waisidx_01/29¢fr1910a_01.html).

* Your company’s/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at:

www.cdc.gov

Workstation Safety

Correct ergonomic configuration of your workstation can reduce or prevent effects such
as fatigue, pain, and strain. Minimize or eliminate these effects by configuring your
workstation to promote neutral or relaxed working positions.

A (o7 1[o)\] MUSCULOSKELETAL AND REPETITIVE MOTION

HAZARD. These hazards are caused by potential risk factors that include but are not
limited to repetitive motion, awkward posture, forceful exertion, holding static unhealthy
positions, contact pressure, and other workstation environmental factors.

To minimize musculoskeletal and repetitive motion risks:

» Use equipment that comfortably supports you in neutral working positions and
allows adequate accessibility to the keyboard, monitor, and mouse.

* Position the keyboard, mouse, and monitor to promote relaxed body and head
postures.
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Safety and EMC Compliance Information
Safety and Electromagnetic Compatibility (EMC) Standards

Safety and Electromagnetic Compatibility (EMC) Standards

U.S. and
Canadian Safety
Standards

c(UL)us

Canadian EMC
Standard

European Safety
and EMC
Standards

C€

Australian EMC
Standards

C

XXii

This section provides information on:
* U.S. and Canadian Safety Standards
» Canadian EMC Standard
* European Safety and EMC Standards
* Australian EMC Standards

This instrument has been tested to and complies with standard UL 61010A-1, “Safety
Requirements for Electrical Equipment for Laboratory Use, Part 1: General
Requirements” and with standard UL 61010-2-010, “Particular Requirements for
Laboratory Equipment for the Heating of Materials.”

This instrument has been tested to and complies with standard CSA 1010.1, “Safety
Requirements for Electrical Equipment for Measurement, Control, and Laboratory Use,
Part 1: General Requirements.”

This instrument has been tested to and complies with ICES-001, Issue 3: Industrial,
Scientific, and Medical Radio Frequency Generators.

Safety

This instrument meets European requirements for safety (Low Voltage Directive
2006/95/EC). This instrument has been tested to and complies with standards

EN 61010-1:2001, “Safety Requirements for Electrical Equipment for Measurement,
Control and Laboratory Use, Part 1: General Requirements” and EN 61010-2-010,
“Particular Requirements for Laboratory Equipment for the Heating of Materials,” and
with standard EN 61010-2-081:2002+A1:2003 “Particular Requirements for Automatic
and Semi-Automatic Laboratory Equipment for Analysis and Other Purposes.”

EMC

This instrument meets European requirements for emission and immunity (EMC
Directive 2004/108/EC). This instrument has been tested to and complies with standard
EN 61326 (Group 1, Class B), “Electrical Equipment for Measurement, Control and
Laboratory Use — EMC Requirements.”

This instrument has been tested to and complies with standard AS/NZS 2064, “Limits

and Methods Measurement of Electromagnetic Disturbance Characteristics of Industrial,
Scientific, and Medical (ISM) Radio-frequency Equipment.”
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Chapter 1

Overview

This chapter covers:

B About the 7500/7500 Fast System .. ...t 2
B HowtoUse ThisGuide ........ ...ttt 4
B Recommended Maintenance Schedule. . ............ ... ... ... ......... 5
B Maintain the Computer Hard Drive(s) . ......... ... .. 6

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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About the 7500/7500 Fast System

About the 7500/7500 Fast System

The Applied Biosystems 7500/7500 Fast Real-Time PCR System uses
fluorescence-based polymerase chain reaction (PCR) reagents to provide:

* Quantitative detection of target nucleic acid sequences (targets) using real-time
analysis.

* Qualitative detection of targets using post-PCR (endpoint) analysis.

* Qualitative analysis of the PCR product (achieved by melt-curve analysis that occurs
post-PCR).

About Data The 7500/7500 Fast system collects raw fluorescence data at different points during a
Collection PCR, depending on the type of run that the instrument performs:

Run Type Data Collection Point
Real-time Standard curve The instrument collects data following each extension
runs step of the PCR.
Relative standard
curve

Comparative Ct

(AACT)
Post-PCR The instrument collects data:
(endpoint) | o otypi « Before the PCR (F /ab iment
runs enotyping efore the P (For presence absence experiments,
data collection before the PCR is optional but
recommended.)
e (Optional) During the PCR. The instrument can collect
data during the run (real-time); collecting data during
Presence/Absence

the run can be helpful for troubleshooting.
e After the PCR.

Regardless of the run type, a data collection point or read on the 7500/7500 Fast
instrument consists of three phases:

1. Excitation — The instrument illuminates all wells of the reaction plate, exciting the
fluorophores in each reaction.

2. Emission — The instrument optics collect the residual fluorescence emitted from the
wells of the reaction plate. The resulting image consists only of light that
corresponds to the range of emission wavelengths.

3. Collection — The instrument assembles a digital representation of the residual
fluorescence collected over a fixed time interval, then stores the raw fluorescence
image for analysis.

After a run, the 7500 software uses regions of interest (ROI), optical, dye, and
background calibration data to determine the location and intensity of the fluorescence
signals in each read, the dye associated with each fluorescence signal, and the
significance of the signal.

Notes
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About the 7500/7500 Fast System

About the Filters The 7500/7500 Fast system uses five filters to support the following system dyes:

Filter 1 Filter 2 Filter 3 Filter 4 Filter 5
e FAM™ dye e JOE™ dye e TAMRA™dye | ¢ ROX"dye Cy5°® dye
e SYBR® e VIC®dye e NED" dye e Texas Red®
Green dye e CY3°dye dye

For More For information on

Information » The 7500/7500 Fast system — Refer to the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Software Help.

Note: To access the Help, select Help » 7500 Software Help from within the 7500
software.

* Genotyping experiments — Refer to Applied Biosystems 7500/7500 Fast Real-Time
PCR System Getting Started Guide for Genotyping Experiments.

» Presence/absence experiments — Refer to Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Presence/Absence Experiments.

» Relative standard curve and/or comparative C; (C;) experiments — Refer to
Applied Biosystems 7500/7500 Fast Real-Time PCR System Getting Started Guide
for Relative Standard Curve and Comparative C, Experiments.

» Standard curve experiments — Refer to Applied Biosystems 7500/7500 Fast
Real-Time PCR System Getting Started Guide for Standard Curve Experiments.

Notes
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How to Use This Guide

How to Use This Guide

This guide describes how to maintain the Applied Biosystems 7500/7500 Fast Real-Time
PCR System. Chapters 2 through 5 of this manual describe calibrations that you must

perform as regular maintenance of the 7500/7500 Fast system. Chapter 6 and the appendices
contain maintenance procedures that you may need to resolve infrequent problems.

Notes

Chapter/
Appendix

Title

Description

2

Perform the Regions of
Interest (ROI) Calibration

Describes how to perform an ROI calibration, which
allows the 7500 software to map the positions of the
wells on the sample block so that it can associate the
fluorescence collected during a run with specific
wells of the plate.

Perform the Background
Calibration and Optical
Calibration

Describes how to perform background and optical
calibrations where the:

e Background calibration allows the 7500 software
to remove the background fluorescence from
experiment data.

e Optical calibration compensates for the physical
effects of the fifth filter present in 7500/7500 Fast
systems.

Perform the Dye
Calibration

Describes how to perform dye calibrations, which
allow the software to distinguish the individual
contribution of each dye in the total fluorescence
collected by the instrument.

Verify the Instrument
Performance

Describes how to perform a TagMan® RNase P
Instrument Verification Plate run that can be used to
verify the performance of a 7500/7500 Fast system.

User-Performed
Maintenance

Describes how to:

¢ Replace the user-serviceable parts of the
7500/7500 Fast system.

e Resolve infrequent problems that can occur
during instrument use.

Store, Move, and Install
the 7500/7500 Fast
System

Describes how to store, move, and reinstall the
components of the 7500/7500 Fast system.

Create a Custom Dye
Plate

Describes how to create a dye plate that can be used
to calibrate the 7500/7500 Fast system for a dye not
manufactured by Applied Biosystems.

Create a Background
Plate

Describes how to create a background plate in the
event that one is unavailable.
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Recommended Maintenance Schedule

Recommended Maintenance Schedule

The following table displays the recommended maintenance schedule for the 7500/7500
Fast instrument and computer. The procedures listed in the table are intended for the
user(s) of the 7500/7500 Fast system. To ensure proper operation of your instrument,
perform the regular weekly, monthly, and semiannual maintenance indicated below.

IMPORTANT! The numbered lists in the table below indicate that the tasks must be
performed in sequence.

Perform... User-Performed Maintenance Task See Page

Weekly e Check the computer disk space. If necessary, archive or back up 6
your experiment files.

¢ Power off the computer controlling the 7500/7500 Fast —
instrument, then after 30 sec, power on the computer.

¢ Clean the surface of the 7500/7500 Fast instrument with a -
lint-free cloth.

IMPORTANT! Do not use organic solvents to clean the 7500/7500
Fast system.

Monthly 1. Check the lamp status. If necessary, replace the halogen lamp. 58
2. Perform a background calibration.* 20

3. Run disk cleanup and disk defragmentation. 6

Semiannually | 1. Check the lamp status. If necessary, replace the halogen lamp. 58
(6 Months) 2. Perform a regions of interest (ROI) calibration. 7
3. Perform a background calibration. 20

4. Perform an optical calibration. 25

5. Perform a dye calibration. 31

6. Perform an RNase P instrument verification run. 45

As needed ¢ Decontaminate the 7500/7500 Fast instrument. 59
¢ Replace the Halogen Lamp. 63

¢ Replace the 7500/7500 Fast instrument fuses. 66

¢ Update the Windows operating system. 67

¢ Update the 7500 software. 68

I You can perform a background calibration to check for contamination. If any parts of the optics are
replaced or moved, you must run an ROI calibration, a background calibration, an optical calibration,
a dye calibration, and an RNase P instrument verification run.

Notes
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Maintain the Computer Hard Drive(s)

Maintain the Computer Hard Drive(s)

When to
Defragment and
Clean Up the
Hard Drive

For More
Information

* At least once every month

* When a message is displayed by the Windows operating system instructing you to
defragment

In the desktop, select Start » Help and Support to access the Help for the Windows
operating system. Use the search function of the Help to find information on the
“Disk Cleanup” and “Disk Defragment” utilities.

IMPORTANT! Do not run the disk management utilities and 7500 software at the same
time.

Archive and Back Up EDS Files

Archive EDS Files
Regularly

Back Up EDS
Files

Develop a Data
Management
Strategy

Check Disk
Space

Notes

To conserve space on the computer hard drive, older EDS files can be archived using a
data compression utility. Several commercially available compression utilities are
available. PKZIP and *.arc are archive formats common to the Microsoft® Windows®
operating system.

Applied Biosystems strongly recommends that you back up your experiments.

Backing up data:
* Protects against potential loss of data caused by an unforeseen failure of the
computer or its hard drive(s).

» Conserves space on the hard drive and optimizes performance, if you remove old
data after backing up.

Applied Biosystems recommends developing a strategy for managing the files produced
by the 7500 software.

Note: Real-time runs generate significantly more data than genotyping or
presence/absence experiments. During one day of real-time operation, the 7500/7500
Fast system can generate more than 10 MB of data.

If you perform real-time experiments on your 7500/7500 Fast system, check the amount
of available space on your hard drive weekly. When the hard drive is within 20% of
maximum capacity, transfer the older data to a backup storage device.
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Perform the Regions of Interest (ROI)
Calibration

This chapter covers:

B OV VICW. « v vttt e e e e e e e e e e 8
B Prepare the ROI Calibration Plate. . ............ ... ... ... ..., 9
B Perform the Calibration ............. .. .. .. . . ... 12
B Perform an Automated ROI Calibration. . ............................ 12
B Perform a Manual ROI Calibration .. ............................... 13
B Troubleshoot the ROI Calibration. . . ........... .. ... ... .. ... ... 17

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Overview

Overview

A regions of interest (ROI) calibration maps the positions of the wells on the sample
block of the Applied Biosystems 7500/7500 Fast Real-Time PCR System. The 7500
software uses the ROI calibration data to associate increases in fluorescence during a run
with specific wells of the plate. The instrument uses a set of optic filters to distinguish
the fluorescence emissions gathered during runs. You must generate a calibration image
for each individual filter to account for minor differences in the optical path.

Note: The ROI calibration is a user-performed maintenance procedure.

Time Required 30 min

Materials
Required

/ﬁ 1
AR |

ROI Calibration goggles C;;rifuge with

Applied Biosystems Plate Powder-free plate adapter
Real-Time PCR gloves
System Spectral
Calibration Kit

Safety

When to Perform  Perform an ROI calibration:

the Calibration * When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dye calibrations and the instrument verification run.

* Every 6 months, or as often as necessary, depending on instrument use.
» After replacing the lamp.

IMPORTANT! After every ROI calibration, you must perform a background calibration,
optical calibration, dye calibration, and instrument verification.

Notes
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Prepare the ROI Calibration Plate

Prepare the ROI Calibration Plate

Standard Plates Use the plate appropriate for your 7500/7500 Fast system.
Versus Fast

Plates Standard Plates - 7500 Systems Fast Plates - 7500 Fast Systems

Notched corner at top right Notched corner at top left

A1 at
A1 at corner nt%tsngg
opposite corner
from
notched
top-right
corner (A12).
100-pL : : 30-uL
-H I | maximum 9 ]
maximum reaction T
reaction voume —U UV VYV VYV
Vortex standard plates to ensure complete Centrifuge Fast plates to ensure that all
mixing, then centrifuge to ensure that all reagents are in the bottom of the well.
:'I(:;glgents are contained in the bottom of the Do not vortex Fast plates. Vortexing can

cause loss of smaller reaction volumes.

ACAUTION Optical 96-Well Fast ACAUTION Standard plates are not

Ellateks do not fit correctly into the standard compatible with the 7500 Fast system and
ock. may be crushed by the 96-Well Fast Block.

Prepare the Plate IMPORTANT! Wear powder-free gloves when you handle the ROI calibration plate.

1. Obtain the ROI calibration plate from the spectral calibration kit in the freezer.

2. Allow the ROI calibration plate to warm to room temperature (approximately 5 min).

IMPORTANT! Do not remove an ROI calibration plate from its packaging until you
are ready to run it. The fluorescent dye in the wells of the plate is photosensitive.
Prolonged exposure to light can diminish the fluorescence from the plate.

Notes
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Prepare the ROI Calibration Plate

3. Remove the ROI calibration plate from its packaging. Leave the optical film on the
plate.

IMPORTANT! Do not discard the packaging for the ROI calibration plate. The plate
can be used up to three times if it is stored in its original packaging sleeve.

4. (Standard plates only) Vortex the ROI calibration plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

(The remaining steps apply to both standard and Fast plates.)

5. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

6. Verify that the liquid in each well of the ROI calibration plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incorrect
\ Liquid is at ¢ Not centrifuged with enough force,
\ bottom of well. or

¢ Not centrifuged for enough time

Notes
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Prepare the ROI Calibration Plate

Load the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast system) with the

notched A12 position at notched A1 position at
the top-right of the tray. the top-left of the tray.

Notes
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Perform the Calibration

Perform the Calibration

Automated The 7500 software allows you to perform the ROI calibration automatically or manually.
Versus Manual

Calibrations ROI -

Calibration Description Use for... See Page

Automatic (Novice users) A wizard interface | Regular calibrations 12
guides you through the
calibration.

Manual (Advanced users) An interface ¢ Regular calibrations 13
similar to previous versions of e Custom dye calibration
the software that allows you to (see page 75)

perform the calibration manually.

Perform an Automated ROI Calibration

Start the 1. In the 7500 software, select Instrument » Instrument Maintenance Manager.

Calibration . .
2. In the ROI screen of the Instrument Maintenance Manager, click Start Calibration.

3. Complete the calibration as instructed by the wizard.

The ROI Calibration dialog box displays three tabs:

* Setup — Displays instructions for setting up the ROI calibration. Clicking Next
prompts opens the Run tab.

* Run — Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the ROI Calibration”
on page 17.

Notes
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Perform the Calibration

Perform a Manual ROI Calibration

Start the 1. In the 7500 software, select Instrument » Instrument Maintenance Manager.

Calibration _
2. In the ROI tab of the Instrument Maintenance Manager, click Start Manual

Calibration.

3. In the ROI Inspector dialog box:
a. In the Exposure Time field, enter 2048.
b. Select Filter A (Filter 1).

X
CCD Control/Settings
Exposure Time [ms] |2048 J 3a
Lamp Contral
’m Move Block
Capture Image From
Fiter & A 3b
B
CC
L]
CE

4. Click Snapshot to generate an ROI image.

5. Determine if your ROI image is acceptable (the figures below show unsaturated and
oversaturated images). Wells in an acceptable image:

* Must be as bright as possible without oversaturating. (When you generate the
ROI calibration, a warning is displayed if wells are oversaturated.)

* Can contain some, but do not have to contain any, red pixels, which represent
saturation.

Normal Over

Unsaturated Saturation Saturated

Good Acceptable Not Acceptable

6. If your ROI image is acceptable, go to step 7.

If your ROI image is oversaturated, decrease the Exposure Time by half, then
click Snapshot. Repeat until you obtain an acceptable ROI image.

If you cannot obtain an acceptable image, see “Troubleshoot the ROI Calibration”
on page 17.

Notes
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Perform the Calibration

7. Click Generate Calibration.
The 7500 software takes a snapshot, then displays a message box or an ROI image:

If the software displays: Do the following:

a. Click OK.

7500 v2.0 .
b. Decrease the Exposure Time by

The image is over exposed and cannot be used to calibrate the instrument.,
A Flease reduce the exposure time and try again. half (See Step 3aon page 13)
c. Repeat steps 3 and 5.
or
7500 v2.0 X

(1) Low exposure

(23 Missing calibration plate
(33 Lamp is off or burned out
(4} Shutter is closed

@ Image exposure is too low For valid calibration, possible causes:

The calibration process will not continue with the current image.

Flease increase the exposure time and try again,

A very faint ROl image, or you cannot generate a See “Troubleshoot the ROI Calibration”
successful calibration. on page 17.

An acceptable Calibration Image Verify that the:

Note: Green circles appear around all wells e Wells Found value is 96.

indicating that the wells calibrated successfully.

Capture Image From
Fiter: ® A
B
’e
CD
CE

PiselIntersty 138

P | Successful
Snagol calibration —
Wells Found

Save Caltraton must be 96

(AR R A ¢ ROI Image displays a green circle
e around each well area.

Note: A green circle indicates that the region of
interest for the well position is bright enough.

8. Click Save Calibration.

The software saves the newly generated ROI calibration for Filter 1. “OK” appears
next to Filter 1 in the Filter Masks Loaded section of the ROI Inspector.

Notes
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Perform the Calibration

9. Repeat steps 3 through 8 for the remaining filters, resetting the Exposure Time to
2048 before performing the calibration for each filter. The ROI calibration is
complete when Filter Masks Loaded for all the filters displays OK.

CLCD Control/Settings
Exposure Time [ms] 2048 ﬂ
Lamp Control

\dle - Move Block,

Capture Image From
Filter: € &

B

—C

D

+ E

Fixel Intensity 138
Wwells Found 56

Snapshat
Generate Calibration

Save Calibration

Filter Masks Loaded

A Ok

B: OK

Ok Calibration is complete when Filter
D Ok Masks Loaded is OK for all Filters
E: OK

Done

10. Click Done.

Notes
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Perform the Calibration

Unload the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to close it.

J/\Push

2. Place the calibration plate inside its packaging sleeve. If you plan to perform
background and optical calibrations:
* Within the next 8 hr, keep the ROI calibration plate at room temperature. The
optical calibration uses the ROI calibration plate.
* On another day, return the packaged plate to the spectral calibration kit in the
freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use it up to three times after you open it.

Continue with ““Perform the Background Calibration and Optical Calibration” on
page 19.

IMPORTANT! After you perform an ROI calibration, you must also perform a
background calibration (see page 20), an optical calibration (see page 25), dye
calibrations (see page 32), and instrument verification (see page 46).

Notes
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Troubleshoot the ROl Calibration

Troubleshoot the ROI Calibration

Problem/Symptom Possible Cause Action
ROI Calibration The sample block may be | 1. If the CCD Control Settings in the ROI Inspector displays
Failed in its lowered position. “Block Up,” click Block Up, to raise the block.

CLCD Control/Settings
Exposure Time [ms] 1024 4

I=|

Lamp Control

Idle - Black Lp '| Click

Capture Image From
Filter: & &

2. Check that the heated cover assembly is pulled all the way forward

to ensure that the tray can be pushed in properly. If the 7500/7500
ROI Image is Faint Fast system has a heated cover latch installed, check that the latch
is in a locked position.

ANMNINNININI

—— Heated cover
assembly

3. If the ROI calibration continues to fail, check the status of the
halogen lamp within the 7500/7500 Fast instrument (see “Monitor
the Lamp Status” on page 58), then replace the lamp if necessary
(see “Replace the Halogen Lamp” on page 63).

Notes
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Troubleshoot the ROI Calibration

Notes
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Chapter 3

Perform the Background Calibration
and Optical Calibration

This chapter covers:

B Perform the Background Calibration ... .......... ... ... ... .. ... ....... 20
B Prepare the Background Calibration Plate. .. ......................... 21
B Perform the Background Calibration. . ............ .. ... .. ... ... ..... 23
B Perform the Optical Calibration . .. ........ ... ... ... ... ... ... ...... 25
B Prepare the Calibration Plate .. .......... ... ... ... ... ... ...... 25
B Perform the Optical Calibration. . .............. ... .. ... .. ... ....... 28
B Troubleshoot the Background Calibration .. ............................. 30

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Perform the Background Calibration

Perform the Background Calibration

Time Required

Materials
Required

When to Perform
the Calibration

Background
Fluorescence

Guidelines for
Calibration

Notes

20

During a background calibration, the 7500/7500 Fast system:
» Performs reads of a background plate containing PCR buffer for 10 min at 60 °C.
» Averages the spectra recorded during the run and extracts the resulting spectral
component to a calibration file.

The 7500 software then uses the calibration file during subsequent runs to remove the
background fluorescence from the run data.

Note: The background calibration is a user-performed maintenance procedure.

30 min
Background
Plate Safety
q,r,, . goggles
/ \| %3
A |
Applied Biosystems 7500/7500 Powder-free CentriSé with plate
Fast Real-Time PCR System gloves adapter

Spectral Calibration Kit

Perform a background calibration:

* When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dye calibrations and the instrument verification run.

* Monthly, or as often as necessary, depending on instrument use.
+ After replacing the lamp.

Fluorescence data collected by the 7500/7500 Fast system includes a fluorescence signal
inherent to the system, referred to as background fluorescence. Background fluorescence
is a composite signal found in all spectral data. This signal consists of fluorescence from
several sources, including:

* Background electronic signal

* Contaminants in the sample block

» The plastic consumable (plates and caps)

» Make sure the centrifuge you use is clean. Before centrifuging, wipe down the
bucket using a tissue.

» Handle the calibration plates with care to prevent contamination. Do not place plates
on a lab bench, which may contaminate the plate. Always put calibration plates back
into their original bags.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Chapter 3 Perform the Background Calibration and Optical Calibration n
Perform the Background Calibration

Prepare the Background Calibration Plate

Prepare the Plate IMPORTANT! Wear powder-free gloves when you handle the plate.

1. Obtain the prepared background plate from the spectral calibration kit in the freezer.
2. Allow the background plate to warm to room temperature (at least 5 min).

3. Remove the background plate from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The background plate can
be used up to three times if it is stored in its original packaging sleeve.

4. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

(The remaining steps apply to both standard and Fast plates.)

5. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The plate must be well mixed and centrifuged.

6. Verify that the liquid in each well of the background plate is at the bottom of the well.
If not, centrifuge the plate again at a higher rpm and for a longer period of time.

IMPORTANT! Do not allow the bottom of the background plate to become dirty.
Fluids and other contaminants that adhere to the bottom of the plate can contaminate
the sample block and cause an abnormally high background signal.

Correct Incorrect
/ ' ‘. \ Liquid is at ¢ Not centrifuged with enough force, or
/ bottom of well. ¢ Not centrifuged for enough time

Notes

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide 21




m Chapter 3 Perform the Background Calibration and Optical Calibration
Perform the Background Calibration

Load the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast system) with the
notched A12 position at notched A1 position at the
the top-right of the tray. top-left of the tray.

Note: If you cannot open the tray, the sample block may be in its raised position, locking the
tray door position. To lower the block, select Instrument » Calibrate, then exit the ROI
Inspector.

Notes
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Perform the Background Calibration

Perform the Background Calibration

Perform the 1. In the 7500 software, select Instrument » Instrument Maintenance Manager.

Calibration ,
In the Instrument Maintenance Manager, select the Background tab.

In the Background tab, click Start Calibration.

A

Complete the calibration as instructed by the wizard.
The Background Calibration dialog box displays four tabs:
* Overview — Displays information describing the calibration.

* Setup — Displays instructions for setting up the background calibration.
Clicking Next prompts opens the Run tab.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

» Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the Background
Calibration” on page 30.

Note: Before starting the calibration, the instrument may pause (up to 10 min) to allow
the heated cover to reach temperature.

Notes
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Perform the Background Calibration

Unload the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.
b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.

J/\Push

2. Place the calibration plate inside its packaging sleeve, then return the packaged plate
to the spectral calibration kit in the freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use the plate up to three times after you open it.

If necessary, continue with “Perform the Optical Calibration” on page 25.

You must perform an optical calibration (see page 25), dye calibrations (see page 32),
and instrument verification (see page 46) if you are performing the background
calibration:

* As part of your semiannual maintenance

» After replacing or moving any parts of the optics

For more information, see “Recommended Maintenance Schedule” on page 5.

Notes
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Perform the Optical Calibration

Perform the Optical Calibration

The optical calibration generates data that allows the 7500 software to compensate for the
physical effects of the fifth filter in the 7500/7500 Fast system.

Note: The optical calibration is a user-performed maintenance procedure.

Time Required 10 min

Materials ROI calibration plate
Required

When to perform  Perform an optical calibration:
the Calibration

*  When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dye calibrations and the instrument verification run.

» Every 6 months, or as often as necessary, depending on instrument use.

Prepare the Calibration Plate

Prepare the Plate If you kept your ROI calibration plate at room temperature after performing an ROI
calibration (see Chapter 2), skip to step 5 on page 26 to spin down any condensation that may
have formed when the plate was at room temperature. If the ROI calibration plate is in the
freezer, go to step 1.

IMPORTANT! Wear powder-free gloves when you handle the plate.

1. Obtain the ROI calibration plate from the spectral calibration kit in the freezer.
2. Allow the ROI calibration plate to warm to room temperature (at least 5 min).

3. Remove the ROI calibration plate from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The ROI calibration plate
can be used up to three times if it is stored in its original packaging sleeve.

Notes
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Notes

Perform the Optical Calibration

4. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

(The remaining steps apply to both standard and Fast plates.)

. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The ROI calibration plate must be well mixed and centrifuged.

. Verify that the liquid in each well of the ROI calibration plate is at the bottom of the

well. If not, centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incorrect
‘\ Liquid is at ¢ Not centrifuged with enough force,
/ \ \ bottom of well. or

¢ Not centrifuged for enough time

26
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Perform the Optical Calibration

Load the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast system) with the
notched A12 position at notched A1 position at
the top-right of the tray. the top-left of the tray.

Notes
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Perform the Optical Calibration

Perform the Optical Calibration

Perform the 1. In the 7500 software, select Instrument » Instrument Maintenance Manager.

Calibration .
In the Instrument Maintenance Manager, select the Optical tab.

In the Optical screen, click Start Calibration.

0N

Complete the calibration as instructed by the wizard.

The Optical Calibration dialog box displays four tabs:
* Overview — Displays information describing the calibration.
* Setup — Displays instructions for setting up the optical calibration. Clicking
Next prompts opens the Run tab.
* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.
» Analysis — Indicates the calibration status (Passed/Failed).

If you cannot obtain a passing calibration, see “Troubleshoot the Background
Calibration” on page 30.

Note: Before starting the calibration, the instrument may pause (up to 10 min) to allow
the heated cover to reach temperature.

Unload the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the
sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Remove the calibration plate:
a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.

Notes
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Perform the Optical Calibration

2. Place the calibration plate inside its packaging sleeve. Return the packaged plate to
the spectral calibration kit in the freezer.

IMPORTANT! Do not discard the calibration plate. If the plate is stored in its
original packaging sleeve, you can use it up to three times after you open it.

Continue with “Perform the Dye Calibration” on page 31.

Notes
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Troubleshoot the Background Calibration

Troubleshoot the Background Calibration

Problem/Symptom Possible Cause Action
Background One or more wells of the 1. Repeat the calibration using the same background plate.
Calibration Failed background plate produced

2. If the calibration fails again, repeat the calibration using a

spectra that exceed the different background plate.

maximum limit for the
instrument. 3. If the calibration fails again, determine the source of the
contamination, as explained in “How to Identify
Contamination” below.

How to Identify  Signals that exceed the limit of normal background fluorescence may indicate

Contamination fluorescent contaminants on the calibration plate or the sample block. Common
contaminants include ink residue from permanent pens, powder from disposable gloves,
and dust.

To determine the source and location of the contamination:

1. While viewing the raw spectra, locate the contaminated well position(s) by selecting
successively smaller regions of the plate layout.

2. Rotate the background plate 180°, then perform the background calibration again.

3. Repeat step 1 to locate the contamination. If the well position(s) of the
contamination in steps 1 and 3 are:

* Identical — The sample block is contaminated. Decontaminate the sample
block as explained in “Decontaminate the Sample Block” on page 59.

* Reversed — The background plate is contaminated. Discard the background
plate and perform the background run using a new background plate.

If the calibration fails after you replace the background plate and decontaminate the
sample block:

1. Load a plate covered by a piece of black paper into the 7500/7500 Fast instrument.
2. Perform the background run as explained in this chapter.

3. After the run is complete, select all wells of the plate layout.

4

. View the Spectral plot for the peak(s). If a peak is:

* Visible — The optics of your 7500/7500 Fast instrument may be contaminated.
Contact Applied Biosystems as explained in “How to Obtain Support” on

page X.
* Absent — The sample block is contaminated. Decontaminate the sample block
as explained in “Decontaminate the Sample Block™ on page 59.

Notes
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n Perform the Dye Calibration

This chapter covers:

B OOVEIVIEW. .« o oottt e et e e e e e e e e e e e e 32
B Prepare the Dye Calibration Plates. .. ............ ... ... ... 35
B Perform the Dye Calibration. . .......... ... ... .. ... 36
B Troubleshoot the Dye Calibration. . .. ........ ... ... ... ... ... ...... 43

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Overview

Overview

Time Required

Materials
Required

When to Perform
Dye Calibration

Notes
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During a dye calibration, the Applied Biosystems 7500/7500 Fast Real-Time PCR System:
» Collects spectral data from a series of dye standards.
+ Stores the spectral information for the dye standards in a pure spectra calibration file.

The software uses the pure spectra data during experiment runs to characterize and
distinguish the individual contribution of each dye in the total fluorescence collected by
the instrument. After each run, the 7500 software receives data in the form of a raw
spectra signal for each reading. It determines the contribution of each fluorescent dye
used in the sample by comparing the raw spectra to the pure spectra calibration data.
When you save an experiment after analysis, the software stores the pure spectra with the
collected fluorescence data for that experiment.

Note: The dye calibration is a user-performed maintenance procedure.

1 hr

Applied Biosystems 7500/7500
Fast Real-Time PCR System
Spectral Calibration Kit

Safety
Glasses

’?/,\/\\F\ “
ASS |

=——— ' -
Dye Plates '
(CY3®, CY5®, FAM™, JOE™, NED™, ROX™, SYBR® Powder-free Centrifuge with
Green, TAMRA™, TEXAS RED®, and VIC® dyes) gloves plate adapter

Note: If you store Applied Biosystems 7500/7500 Fast Real-Time PCR System dye
plates in their original packaging in the freezer, you can use them to calibrate a
7500/7500 Fast instrument up to 3 times for 6 months after opening them.

Perform a dye calibration:

*  When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dye calibrations and the instrument verification run.

* Every 6 months, or as often as necessary, depending on instrument use.

IMPORTANT! You must perform a background run before every series of dye
calibrations. Because the age and use of instrument components can affect pure spectra
readings, Applied Biosystems recommends performing a dye calibration at least every
6 months.
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Overview

Dye Sets The Applied Biosystems 7500/7500 Fast Real-Time PCR Systems use the following dye
sets for calibration: CY3® dye, CY5® dye, FAM™ dye, JOE™ dye, NED™ dye, ROX™ dye,
SYBR® Green dye, TAMRA™ dye, TEXAS RED” dye, and VIC" dye. The following
figure shows the emission spectrum for each dye, and the filters and wavelengths at
which each dye is read.

Filters

Spectrum
(nm)

Emission /
Spectra Y

e

Pure Dyes ~520 nm ~550 nm  ~580 nm ~610 nm ~650 nm
* FAM * JOE * TAMRA ¢ ROX CY5
* SYBR Green *VIC * NED * TEXAS RED
*CY3

Custom Dye The 7500/7500 Fast system can be used to run assays designed with custom dyes (dyes
not supplied by Applied Biosystems). However, before using custom dyes with the
7500/7500 Fast instrument, you must create and run a custom calibration plate. The 7500
software uses the custom calibration plate to create a spectral standard to distinguish the
custom dye in the fluorescence data collected during the run. See Appendix B for
information on custom dye calibrations.

IMPORTANT! To use a custom dye on your 7500/7500 Fast system, it must fluoresce
within the 520 to 650 nm spectral range measured by the 7500/7500 Fast instrument.

Notes
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Notes
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Overview

About the
Analysis

The product of a dye calibration is a collection of spectral profiles that represent the
fluorescence signature of each dye standard. Each profile consists of a set of spectra that
correspond to the fluorescence collected from the wells of the spectral calibration plate.
The 7500 software plots the resulting data for each spectral profile in a graph of
fluorescence versus filter.

When the 7500 software extracts the calibration data from a dye run, it evaluates the
fluorescence signal generated by each well in terms of the collective spectra for the entire
calibration plate. Dye spectra are generally acceptable if they peak within the same filter
as their group but diverge slightly at other wavelengths (see below).

The 7500 software can compensate for some differences in a spectral profile by replacing
(auto-repairing) the spectra of unacceptable wells with the spectra of other wells on the
reaction plate. However, the software allows only a few replacements and may reject the
calibration if the spectra between neighboring wells vary significantly.

Note: Because the wells in a calibration plate contain dyes at identical concentrations,
the resulting signals for the wells containing each dye should be similar. Among wells
containing the same dye, variations in spectral position and peak position are caused by
minor differences in the optical properties and excitation energy between the individual
wells.

Acceptable Spectra
Spectra peak at the same wavelength and

@ do not diverge significantly
1K}
0z
1 2 a 4 g

Filter

3
08
06
0.4
0.2
——— ]
1 2 3 4 5

Hormalized Fluorescence
=
=

Unacceptable Spectra
Spectra peak at the different wavelengths

Hormalized Fluorescence

0.0

Filter
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Prepare the Dye Calibration Plates

Prepare the Dye Calibration Plates

IMPORTANT! Before performing a dye calibration, you must perform an ROI calibration
(see page 8), a background calibration (see page 20), and an optical calibration (see page 25).

Prepare the IMPORTANT! Wear powder-free gloves when you handle the plate.
Plates

1. Obtain the spectral calibration kit from the freezer, then remove all of the dye plates.
2. Return the spectral calibration kit to the freezer.

3. Allow the dye plates to warm to room temperature (approximately 5 min).

IMPORTANT! Do not remove a dye plate from its packaging until you are ready to run it.
The fluorescent dye in the wells of each dye plate is photosensitive. Prolonged exposure
to light can diminish the fluorescence signal strength of the plate.

Note: If you store Applied Biosystems 7500/7500 Fast Real-Time PCR System dye
plates in their original packaging in the freezer, you can use them to calibrate a
7500/7500 Fast instrument up to 3 times for 6 months after opening them.

Continue with “Perform the Dye Calibration” on page 36.

Notes
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Perform the Dye Calibration

Perform the Dye Calibration

Perform the
Calibration

Notes

36

a & @ Db

In the 7500 software, select Instrument » Instrument Maintenance Manager.
In the Instrument Maintenance Manager, select the Dye tab.

In the Dye screen, select System Dye Calibration.

Click Start Calibration.

Complete the calibration for each plate as instructed by the wizard.

IMPORTANT! The wizard guides you through the calibration of each dye separately.
You must set up, run, and analyze each dye plate independently.

The Dye Calibration dialog box displays four tabs:
* Overview — Displays information describing the calibration.

When the software prompts you to obtain the required materials, select the dyes
that you want to calibrate.

* Setup — Displays instructions for setting up the dye calibration. Clicking Next
prompts opens the Run tab.

When the software prompts you to load each dye plate, prepare and load the
plates as described in “Load a Dye Plate” on page 37.

* Run - Clicking START RUN starts the calibration process and displays the
processing messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the calibration status (Passed/Failed).
When the software prompts you to analyze the spectra collected from each dye plate,
verify the status of the calibration:

» Passed — The 7500/7500 Fast instrument passed the calibration. Go to
“Analyze the Calibration Data” on page 39.

* Failed — The 7500/7500 Fast instrument failed the calibration. Troubleshoot
the error as described in “Troubleshoot the Dye Calibration” on page 43.

Note: Before starting the calibration, the instrument may pause (up to 10 min) to
allow the heated cover to reach temperature.
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Perform the Dye Calibration

Load a Dye Plate Note: Because the wizard guides you through the calibration of each dye separately,
perform the following procedure for each dye that you calibrate.

1. Remove the dye plate that is specified by the software from its packaging.

IMPORTANT! Do not discard the packaging for the plate. The plate can be used up
to three times if it is stored in its original packaging sleeve.

2. (Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

(The remaining steps apply to both standard and Fast plates.)

3. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The plate must be well mixed and centrifuged.

4. Verify that the liquid in each well of the plate is at the bottom of the well. If not,
centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incorrect
Liquid is at ¢ Not centrifuged with enough force,
bottom of well. or
\ ¢ Not centrifuged for enough time

5. Verify that the dye plate that you are about to load matches the dye selected in the
7500 software.

Dye label

6. Push the tray door to open it.

Notes
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Perform the Dye Calibration

7. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast system) with the

notched A12 position at notched A1 position at
the top-right of the tray. the top-left of the tray.

8. Close the tray door. Apply pressure to the right side of the tray door at an angle.

Note: If you cannot open the tray, the sample block may be in its raised position, locking the
tray position. To lower the block, select Instrument » Calibrate, then exit the ROI Inspector.

Notes
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Perform the Dye Calibration

Analyze the Note: Because the wizard guides you through the calibration of each dye separately,
Calibration Data perform the following procedure for each dye that you calibrate.

1. Verify the status of the calibration:
* Passed — The 7500/7500 Fast instrument passed the calibration. Go to step 2.

* Failed — The 7500/7500 Fast instrument failed the calibration. Troubleshoot
the error as described in “Troubleshoot the Dye Calibration” on page 43.

2. Verify the grouping of the dye spectra:
a. In the plate layout, select the wells of the plate.

b. Inspect the raw data. For each spectrum, verify that the peak is:
+ Within the detectable range for the 7500/7500 Fast instrument.
 Free of irregular spectral peaks.
* Present in the correct channel for the dye (see Table 1 on page 41).

If a spectrum does not match the criteria above, troubleshoot the problem as
described in “Troubleshoot the Dye Calibration” on page 43.

Note: Among wells containing the same dye, variations in spectral position and
peak position are caused by minor differences in the optical properties and
excitation energy between the individual wells.

3. Ifall spectra are acceptable, then click Next.

1|/ Dye Calibration E
Analysis Analysis Help ),
~ Ovenview =
) a Instructions:; Feview the pure dye spectra. Ifthe calibration passed, click "Next' to continue. Results are saved ifthe calibration passes. Click "Save Results”
1 _ . to save the failed calibration results
. Setup
2a —pe RS <[ Yiew Plate Layout | wel Table |
—————————— Ul —
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Perform the Dye Calibration

4. Remove the calibration plate:

I VL WIed PHYSICAL INJURY HAZARD. During instrument

operation, the sample block can be heated to 100 °C. Before performing the
following procedure, be sure to wait until the sample block reaches room
temperature.

a. Push the tray door to open it.

b. Remove the calibration plate.

c. Push the tray door to close it.

d. Place the calibration plate inside its packaging sleeve. Return the packaged
plate to the spectral calibration kit in the freezer.

Note: If you store Applied Biosystems 7500/7500 Fast Real-Time PCR System
dye plates in their original packaging in the freezer, you can use them to calibrate
7500/7500 Fast instruments up to 3 times for 6 months after opening them.

5. After you remove the dye plate as instructed, click Finish.

6. Prepare and run the next plate as explained in “Prepare the Plates” on page 35.

Notes
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Perform the Dye Calibration
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Troubleshoot the Dye Calibration

Troubleshoot the Dye Calibration

Problem/Symptom

Possible Cause

Action

One or more raw
spectra are at or
below the detectable
threshold for the
calibration.

e The spectral calibration plate

was centrifuged insufficiently.

e The spectral calibration plate
contains old or insufficient
reagents.

¢ [f you are running a custom
spectral calibration plate, the
dye may not be present at a
sufficient concentration.

1. Unload the 7500/7500 Fast instrument and view the wells of
the spectral calibration plate. If the liquid in the wells is not:

— At the bottom of the wells, centrifuge the plate for a longer
time, then repeat the calibration.

— Equivalent in volume, the plate is not sealed and the
reagents have evaporated. Discard it and run another.

2. If the spectral calibration plate appears to be normal, discard
the plate and run another.

3. If the problem persists, contact Applied Biosystems as
explained in “How to Obtain Support” on page x.

Note: If you are running a custom spectral calibration plate,
create another plate but increase the concentration of the dye
that produced insufficient signal.

One or more raw
spectra exceed the
maximum limit for the
7500/7500 Fast
instrument.

¢ Fluorescent contaminants are
on the sample block(s) or
spectral calibration plate.

¢ If you are running a custom
spectral calibration plate, the
dye may be too concentrated.

The spectra contain
peaks in more than
one filter.

Notes

Fluorescent contaminants are on
the sample block(s) or spectral
calibration plate.

Verify that contaminants are not present by performing a
background calibration as explained in Chapter 3, “Perform
the Background Calibration and Optical Calibration.” If the
background calibration does not show sample block
contamination, the spectral calibration plate may be
contaminated.

Note: If you are running a custom spectral calibration plate,
create another plate but decrease the concentration of the dye
that exceeds the detectable limit.
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Troubleshoot the Dye Calibration

44

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Chapter 5

E Verity the Instrument Performance

This chapter covers:

BOOVEIVIBW. .« . ottt ettt e e e e e e e 46
B SetUpthe Experiment ... .......... . . i 48
B Runthe Experiment . .......... ... .. .t 49
B Analyze the Experiment . .. .......... .. . 51
B Troubleshoot the RNase P Experiment. . .......... ... ... ... .......... 54

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Overview

Overview

Time Required

Materials
Required

When to Perform
the RNase P
Experiment

About the
RNase P Plate

Notes

46

Perform the TagMan® RNase P Instrument Verification Plate run to verify the
performance of an Applied Biosystems 7500/7500 Fast Real-Time PCR System.

1 hr
TagMan® RNase P
Instrument
Verification Plate Safety
goggles
TagMan® RN.a_se P Powder-free Centrifuge with plate
Instrument Verification gloves adapter

Plate Kit

Applied Biosystems recommends performing an RNase P experiment:

*  When installing the 7500/7500 Fast system. You must perform in sequence the ROI,
background, optical, and dye calibrations and the instrument verification run.

» After moving the instrument to another location.
* As needed to verify the function of the 7500/7500 Fast instrument.

The RNase P plate is preloaded with the reagents necessary for the detection and quantitation
of genomic copies of the human RNase P gene (a single-copy gene encoding the RNase
moiety of the RNase P enzyme).

Each well contains:

* 1X TagMan® Fast Universal PCR Master Mix, No AmpErase® UNG

* RNase P primers

* FAM™ dye-labeled probe

* Known concentration of human genomic DNA template
The figure below illustrates the arrangement of the standard and unknown populations on
the RNase P plate. The RNase P plate contains five replicate groups of standards (1250,

2500, 5000, 10,000, and 20,000 copies), two unknown populations (5000 and 10,000
copies), and negative control wells (NC).

1. 2. 3. 4.5.6,.7.8._9 101112

5K-copy Unknown
Population 1

NC STD 1250 STD 2500
STD 5000 STD 10000 STD 20000

I O, . M, m_ O _ O W, >

10K-copy Unknown
Population 2
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Overview

After the run, the 7500 software:

1. Generates a standard curve from the averaged threshold cycle (C;) values of the
replicate groups of standards.

2. Calculates the concentration of the two unknown populations using the standard
curve.

3. Calculates the following to assess the 7500/7500 Fast instrument performance:

[(CopyUnky,) = 3(Scopyunka)] > [(CopyUnky) +3(Scopyunki)]
where:
* CopyUnk, = Average copy number of unknown #1 (5,000-copy population)
O copyunki = Standard deviation of unknown #1 (5,000-copy population)
* CopyUnk, = Average copy number of unknown #2 (10,000-copy population)
O copyunkz = Standard deviation of unknown #2 (10,000-copy population)

Installation Specification

The 7500/7500 Fast instrument passes the installation specification if the inequality
holds and the instrument successfully distinguishes between 5,000 and 10,000 copies
with a statistical confidence level of 99.7%.

To meet the installation specification, you can omit a limited number of outlier wells
from the 5,000- and 10,000-copy unknown populations.

Maximum Number of Outlier Wells That Can Be Removed

Inst t .
nstrumen Unknown .Populatlon Standard Negative
5,000-copy | 10,000-copy (STD) Controls (NC)

7500 System

7500 Fast System

Notes
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Set Up the Experiment

Prepare the TagMan® RNase P Fast Instrument Verification Plate for the run.

Prepare the IMPORTANT! Wear powder-free gloves when you handle the RNase P plate.

RNase P Plate

1.

Obtain the TagMan® RNase P Fast Instrument Verification Plate from the freezer, then
allow the reaction plate to warm to room temperature (for approximately 5 min).

2. Remove the RNase P plate from its packaging.

Notes

(Standard plates only) Vortex the plate for 5 sec.

IMPORTANT! Do not vortex Fast plates.

(The remaining steps apply to both standard and Fast plates.)

Centrifuge the reaction plate for 2 min at less than 1500 rpm.

IMPORTANT! The reaction plate must be well mixed and centrifuged.

Verify that the liquid is at the bottom of each well of the reaction plate. If not,
centrifuge the reaction plate again at a greater rpm and for a longer time.

IMPORTANT! Do not allow the bottom of the RNase P plate to become dirty. Fluids
and other contaminants that adhere to the bottom of the reaction plate can
contaminate the sample block(s) and cause an abnormally high background signal.

Correct Incorrect
Liquid is at the ¢ Not centrifuged with enough force, or
bottom of the well. o Not centrifuged for enough time

48
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Run the Experiment

After preparing the TagMan® RNase P Fast Instrument Verification Plate, load the plate
into the 7500/7500 Fast instrument and start the run.

Load the Plate AWARNING PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

1. Push the tray door to open it.

2. Load the plate into the plate holder in the instrument. Ensure that the plate is
properly aligned in the holder.

Load standard plates Load Fast plates (7500
(7500 system) with the Fast system) with the
notched A12 position at notched A1 position at
the top-right of the tray. the top-left of the tray.

Notes
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Start the Run 1. In the 7500 software, select Instrument » Instrument Maintenance Manager.

Notes

2. In the Instrument Maintenance Manager, select the RNase P tab.
3. In the RNase P screen, click Start RNase P Run.

4. Complete the calibration as instructed by the wizard.

The RNase P dialog box displays four tabs:
* Overview — Displays information describing the calibration.

¢ Setup — Displays instructions for setting up the RNase P run. Clicking Next
prompts opens the Run tab.

* Run - Clicking START RUN starts the run process and displays the processing
messages. Clicking Next opens the Analysis tab.

* Analysis — Indicates the run status (Passed/Failed).

Note: Before starting the run, the instrument may pause (up to 10 min) to allow the
heated cover to reach the correct temperature.

500 Software v.2.0

= =un  Instrument  Analysis  Tools Help

[@] New Experiment ~ 25 open.. [l S3v= - 5 Close | 4 Bport B FrintReport..

Perform an RNase P run to verify the performance of your instrument system

HHazER To perfarm a new RMase P run, click"Start RNase P Run." To apen an existing RNase P run, browse and selectthe file to open, then click "Open.”

Status RNase P Run

H\ StartRNasePRun | OR  Open Existing RNase P Run | stems\7500\experimentsiab-calib-masep.eds | | Browse | | open

RNase P Run Data

Status:
Last Run
Exp. Date:

Status
Last Run:
Exp. Date

- 8ystem Dye -
Status

Last Run:

Exp. Date

- Custom Dye -
Status 1]

Status: Not Run
Last Run

A& Home | Instrument Maintenance

7500 connected
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Analyze the Experiment

Review the data to verify the results of the experiment.

Verify the Results Note: After the 7500 software completes the RNase P run, it automatically analyzes the
of the Analysis run and displays the results in the Analysis screen.

1. In the Analysis screen of the RNase P Run wizard, verify the status of the run:
» Passed — The 7500/7500 Fast instrument passed the RNase P run. Go to step 5
on page 53.

* Failed — The 7500/7500 Fast instrument failed the RNase P run. Go to step 2 to
review the data for outliers.

If the run fails, the automated analysis may have included outliers that caused the
initial analysis to fail. Experimental error may cause some wells to be amplified
insufficiently or not at all. These wells typically produce C values that differ
significantly from the average for the associated replicate wells. If included in the
calculations, these outlying data (outliers) can result in erroneous measurements.

2. In the Amplification Plot, select Ct vs. Well from the Plot Type drop-down list.

3. Verify the uniformity of each replicate population on the reaction plate (controls,
standards, and unknowns) by comparing the groupings of C values:

a. In the plate layout, select the wells containing the 10,000-copy unknown
population (wells rows F, G, and H).

1.2 3. 4.5.6,.7,.8_9_ 10,1112

5K-copy Unknown
Population 1

NC STD 1250 STD 2500
STD 5000 STD 10000 STD 20000

10K-copy Unknown
Population 2

T O©, M, _m_ O _O_ O_ >

b. In the plot, verify that the Cs of the replicate population are equivalent.

Note: The numbers on the X-axis of the plot correspond to the wells of the
reaction plate. Beginning with well A1, the wells are numbered from
left-to-right, and top-to-bottom.

Notes
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Outlier

Notes

E Analysis

c. If an outlier is in the selected population, select the corresponding well in the
plate layout, then click Omit to remove the well from the analysis.

Maximum Number of Outlier Wells That Can Be Removed

Inst t .
nstrumen Unknown .Populatlon Standard Negative
5,000-copy = 10,000-copy (STD) Control (NC)
7500 System
6 0 0
7500 Fast System

IMPORTANT! If the number of outliers exceeds the limit in the table above,
order another RNase P plate and repeat the experiment.

d. Repeat steps 3a through 3¢ for each replicate population (unknowns, standards,
and negative controls) on the reaction plate.

4. Click Reanalyze to analyze the run without the outliers.

If the status of the RNase P Run is “Failed” after performing steps 2 through 4, repeat
the RNase P experiment using a different RNase P plate. If the problem persists,
contact Applied Biosystems as explained in “How to Obtain Support” on page x.

RNase P Analysis

Analysis Help @

u (e Emnrs Review the results from the RMase P run. If the run failed, omit outliers, then click "Reanalyze." Repeat until the run passes. Click Finish to save and

apply the results.

Status: Passed

Amplification Plot | Standard Curve

Plot i i)

< | View Plate Layout

>

| Cmit || Resns\yze H Analysis Settings

ResuITs Thhle |

Select Wells With: |- smeonte@f@

Flot Type:|CTvs Well w  Graph Type

Plot Color:jwell

(_ UL

|
A L alEi
@
Amplification Plot

100

i e

| {37 showinwells ¥ |

[F] View Legend

QOOoQaooooon
e
G)
v s ok . QaQaQooooaon
. mimie|m(os|ssis s s
0 5 10 15 20 25 30 35 40 45 50 55 60 6 70 75 80 &85 90 95
e Qaanooaoooaon
Options =
~
Target [RNase P [+ Threshald R
oot frasor B -
< u | > wells: [l 72 Unknown [5] 20 Standard [ 4 Negative Control 0 Empty
| cancsl | | Previous ‘ | Next | | ‘
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5. Review the standard curve:
a. Select the Standard Curve tab.
b. Click the upper-left corner of the Plate Layout to select all wells.

c. Verify that the R2 value is greater than or equal to 0.990.

If the R2 value is less than 0.990, repeat the RNase P experiment using a different
RNase P plate. If the problem persists, contact Applied Biosystems as explained in
“How to Obtain Support” on page x.

RNase P Analysis Analysis Help @
u Instructions: Review the results from the RMase P run. If the run failed, omit outliers, then click "Reanalyze" Repeat until the run passes. Click Finish to save
53 " and apply the results
Status: Passed | omit || Reanalyze | Analysis Settings
[ i
< | View Plate LayoutT Results Table ]
 Analysis Amplification Plot | Standard Curve
E Ve S 4 SelectWells With: - Select tem- |~ | |
Target |All ~|  PlotColor Default v | B show in Wells ¥
5b :
B R E
Standard Curve
» I I M E E
30 .
°
20
5 g [w fw m = = = s s s s s
27
J = (= s s = = = s s == =]
26
- :  OoooooooooD
Quantity
| 2 1 O 1 G A CA CA CA C
Target: RNase P Slope: -3.502 Y-Inter: 40.93% g2, 0.998 J:ff%: 93.012 T n n n n n & n n n n n
Legend )
[. standard [l Unknown [l Uninown (Flagge iy — |
5¢c — Wells: [ 72 Unknown [] 20 Standard [1] 4 Negative Contral 0 Empty
‘ Cancel | | Previous ‘ | Next | | ‘

6. Click Next, then remove the calibration plate.

| A NLY:1I\[e}d PHYSICAL INJURY HAZARD. During instrument operation,

the sample block can be heated to 100 °C. Before performing the following procedure,
be sure to wait until the sample block reaches room temperature.

a. Push the tray door to open it.
b. Remove the calibration plate.

c. Push the tray door to move it into the instrument.
7. Discard the plate.

8. Click Finish, then click Yes when prompted to save the experiment.

Notes
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Troubleshoot the RNase P Experiment

Problem/Symptom Possible Cause Action

More than the ® Possible contamination Contact your Applied Biosystems service and sales

maximum number of | o Ppjpetting inaccuracy representative to order a replacement TagMan® RNase P
outliers are present Instrument Verification Plate. If the replacement RNase P plate
in RNase P data fails, contact Applied Biosystems technical support or your

service representative for further assistance.

The RNase P plate ¢ Insufficient centrifugation
verification run failed i
* Defective plate seal AWARNING PHYSICAL INJURY HAZARD. During

instrument operation, the sample block can be heated to
100 °C. Before performing the following procedure, be sure to
wait until the sample block reaches room temperature.

1. Unload the RNase P plate from the instrument:
a. Push the tray door to open it.
b. Remove the RNase P plate from the tray.
c. Push the tray back into the instrument.

2. Hold the plate up to a light source, and verify that all wells
contain the same volume of fluid.

If there are differences in fluid volumes, check the heat seal
of the wells with lower volumes for signs of damage or
evaporation.

Also, compare the position of the wells that have lower
volumes with the outliers that you have removed from the
plate. If the well positions coincide, the heat seal on the
plate may be defective and resulted in the evaporation of
the associated samples.

3. Contact your Applied Biosystems service and sales
representative to order a replacement TagMan® RNase P
Instrument Verification Plate. If the replacement RNase P
plate fails, contact Applied Biosystems technical support or
your service representative for further assistance.

Notes
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Chapter 6

~ User-Performed Maintenance

This chapter covers:

B Monitor the 7500/7500 Fast System. . ..., 56

B View the Instrument Log . ........ .. ... 56

B Monitor the Instrument Status .. ............ .. .. . 57

B Monitorthe Lamp Status . .. ........ ... . 58
B Decontaminate the Sample Block. . ........ ... ... .. ... ... ... ... 59
B Monitor the 7500/7500 Fast System. .. ..., 58
B Replacethe Halogen Lamp. . ......... .. ... ... .. ... 63
B Replace the Instrument Fuses. . ......... ... . ... 66
B Update the Windows Operating System. . ...t enenan .. 67
B Update the 7500 Software. . ...t 68

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.

Notes
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Monitor the 7500/7500 Fast System

You can monitor the state of the Applied Biosystems 7500/7500 Fast Real-Time PCR
System using the Function Test, Lamp Status/Replacement, and Instrument Log tools of
the 7500 software. The tools enable you to assess the health of the 7500/7500 Fast system,
check the replacement status of the instrument lamp, and view a recent history of
instrument activity.

View the Instrument Log

Use the Instrument Log to view the recent event history of the 7500/7500 Fast system. The
log displays the major instrument activity for either the most recent 25 runs (including
calibrations), or the events that pertain only to a specific EDS file.

Display the 1. Inthe 7500 software, select Instrument » Instrument Events Log.
Instrument Log , .
2. In the Instrument Events Log dialog box, select either:
» System Log — To view events that occurred during the 25 most recent runs
(experiments) or calibrations.

* Document Log — To view events that pertain only to the experiment currently
open in the 7500 software.

3. Ifnecessary, modify the data displayed by the table by filtering the data and adding
or removing columns.

To... Action

Filter the data in the 1. In the Filter drop-down list, select a property.
events table . o . .
2. Enter the appropriate conditions into the drop-down lists
and fields that appear automatically.
3. Click Apply to filter the data.

Note: To reset the log, select Filter » Show All Records.

Add or remove columns | Click Show Columns, then select the column desired column
to/from the events table | in the drop-down list.

Sort the data in the Click the heading of the column of interest once to sort the
events table data in ascending order. Click the column heading again to
sort the data in reverse order.

Export the contents of 1. Select the rows of interest in the event table,
the instrument event

log 2. Press Ctrl+C to copy the data.

3. Paste the data into a spreadsheet application or a text file.
Note: The software exports the data in tab-delimited format.

4. When you finish viewing the events, click the close box to close the dialog box.

Notes
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Monitor the Instrument Status

Use the Function Test dialog box to perform a high-level diagnostic of the major
7500/7500 Fast system components. In general, you need not perform the function tests
unless you experience a suspected hardware failure, or you are instructed to do so by an
Applied Biosystems representative.

Perform Function 1. In the 7500 software, select Instrument » Function-Test.

Tests of System _
Components 2. Perform function tests as needed.

To test:

* All system components — Click All Tests, then wait for the software to perform
all of the function tests.

* One or more specific components — Click one or more of the following.

USB — Tests the universal serial bus (USB) connection between the

7500/7500 Fast instrument and computer. The test passes if the 7500 software
can establish communication with the 7500/7500 Fast instrument.

CCD — Tests the CCD camera in the 7500/7500 Fast instrument. The test
passes if the camera can capture an image.

Filter Wheel — Tests the filter wheel in the 7500/7500 Fast instrument. The test
passes if the filter wheel controller is running the correct version of firmware.
Shutter — Tests the optic shutter of the 7500/7500 Fast instrument. The test
passes if the shutter controller is running the correct version of firmware.
Lamp — Tests the halogen lamp of the 7500/7500 Fast instrument. The test
passes if the lamp controller is running the correct version of firmware.
Thermal Cycler — Tests the thermal cycler sample block in the 7500/7500 Fast
instrument. The test passes if the thermal cycler controller is running the
correct version of firmware.

When the 7500 software completes a test, the software reports the pass/fail status of
the test and provides a description of the outcome.

Function Test !|
Test FPassiFail Description
| UsB | Pass |USB check passed.
| cep | Pass [cCD check passed.
| Fitervwheel | Pass [Filter Wheel check passed.
| smtter | Pass |Shutter check passed.
| Lamp | Pass |Lamp check passed.
| Thermo Cycler | Pass [Therma Cycler check passed.
| AlTests | Pass
[ close |

3. When you finish testing, click Close.

Notes
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Monitor the Lamp Status

Use the Lamp Status/Replacement dialog box to monitor the status of the halogen lamp
that the 7500/7500 Fast instrument uses to illuminate samples during runs.

Check the Lamp  Inthe 7500 software, select Instrument » Lamp Status/Replacement to determine the status
Status  of the halogen lamp.

Lamp Status / Replacement !|
Current Lamp Status
Condition: Good
UUsage (Hours): 1]
Lamp Current: Unknown
Date Last Replaced:  10/01/2007
Replace Lamp

You must resetthe lamp timer
after replacing the lamp.

[MOTE: The lamp timer can only be
resetwhen the instrument is idle ]

| Reset Lamp Timer

| Close |

The Lamp Status/Replacement dialog box displays:
» Condition — Indicates one of the following conditions:
— Good — The lamp is functioning well and does not need to be replaced. Click Close.

— Failed — The lamp bulb must be replaced. Click Close, then replace the lamp as
explained in “Replace the Halogen Lamp” on page 63.

— Change Soon — The lamp usage is above 2000 hrs; Applied Biosystems recommends
that you replace it. Click Close, then decide whether or not to replace the lamp. If you
choose to replace the lamp, see “Replace the Halogen Lamp” on page 63.

» Usage (Hours) — The total number of hours that the lamp has been illuminated.

* Lamp Current — The output current of the lamp in amperes (A). Low current can
indicate a potential future failure of the lamp.

* Date Last Replaced — The date of the last lamp replacement.

Warnings The 7500 software can display the following warnings before or during a run:

Message Description

Warning - Cannot detect sufficient current | The lamp current is below the acceptable level at the start of the run. You cannot

from lamp. Either lamp is not installed proceed with the run until you replace the halogen bulb as explained in “Replace
properly or needs to be replaced. the Halogen Lamp” on page 63.

Warning - Cannot detect sufficient current | The 7500 software stopped the run because the lamp current decreased below the
from lamp. Either lamp is not installed acceptable level during the run. You cannot proceed with the run until you replace
properly or needs to be replaced. the halogen bulb as explained in “Replace the Halogen Lamp” on page 63. Click

OK in the message box, inspect the Instrument Log, then replace the lamp bulb.

Warning - The lamp usage has exceeded The lamp usage exceeds 2000 hr at the start of a run. Click Cancel Run, then
2000 hr. We recommend replacing the lamp | replace the lamp, or click Continue Run.
soon to ensure optimal assay performance.

Rerun ROI, Background, Optical and Dye calibrations.

Notes
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Decontaminate the Sample Block

Perform the following procedure to eliminate fluorescent contaminants from the sample
block of the 7500/7500 Fast instrument. Fluorescent contamination is generally evident

in failed background runs where one or more wells consistently exhibit abnormally high
signals.

A (o7:\8]1{e))'] PHYSICAL INJURY HAZARD. Do not remove the instrument cover.

There are no components inside the 7500/7500 Fast system that you can safely service
yourself. If you suspect a problem, contact an Applied Biosystems Service Representative.

A (.UI[o)\] PHYSICAL INJURY HAZARD. During instrument operation, the

sample block can be heated to 100 °C. Before performing the following procedure, be sure to
wait until the sample block reaches room temperature.

A (.\1{el\] Before using a cleaning or decontamination method other than those

recommended by the Applied Biosystems, verify with Applied Biosystems that the proposed
method will not damage the equipment.

Time Required 30 min

Materials 95% ethanol  10% bleach

. i i Safet
Required solution _solution glasseys Screwdriver

Cotton or nylon
swabs and
lint-free cloths

Pipette (100-pL)

with pipette tips Powder-free

gloves

Deionized
water

Clean the IMPORTANT! Wear powder-free gloves when you perform this procedure.
Sample Block

1. Identify the contaminated wells of the sample block (see “How to Identify
Contamination” on page 30).

2. Remove the plate and the tray holder from the 7500/7500 Fast instrument:
a. Push the tray door to open it.

b. Remove the plate and the tray holder.

Notes
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c. Close the tray door. Apply pressure to the right side of the tray door at an angle.

Z;X Push

3. Manually raise the block:

a. In the 7500 software, select Instrument » Instrument Maintenance
Manager.

b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

c. In the ROI Inspector dialog box, click Move Block.
d. When the ROI Inspector dialog box displays “Block Down,” click Done.

4. Power off, then unplug the 7500/7500 Fast instrument. Allow it to cool for 15 min.

5. Open the access door to the 7500/7500 Fast instrument.

a. Insert a thin screwdriver into the keyhole on the edge of the access door, then
push to unlatch the door.

b. Open the access door.

a b

=

ES=

sS=
3

Q%} i

:'9"@\..5,%

6. Lift the latch, then push the heated cover door to the back of the instrument.

A

Notes
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7. Clean the contaminated wells of the sample block using a small volume of deionized
water:

a. Pipette a small volume of deionized water into each contaminated well.
b. Pipette the water up and down several times to rinse the well.

Pipette the water to a waste beaker.

o

d.

e. Using a lint-free cloth, absorb the excess deionized water.

Using a cotton swab, scrub inside of each contaminated well.

8. Pull the heated cover door to the front of the 7500/7500 Fast instrument. Lift the
latch, then secure the heated cover door to the cross bar.

10. Plug in, then power on the 7500/7500 Fast system.

11. Verify that you have eliminated the contamination by performing a background
calibration run (see “Perform the Background Calibration” on page 20).

Notes
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Notes
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12.

13.

14.

15.

16.

If the contamination remains, repeat steps 1 through 6, then clean the contaminated
wells of the sample block using 95% ethanol solution:

a. Pipette a small volume of 95% ethanol solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times to
rinse the well.

c. Pipette the ethanol solution to a waste beaker.

IMPORTANT! Always use deionized water to rinse wells after cleaning with bleach
or ethanol solution.

Repeat steps 7 through 11 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

If the contamination remains, repeat steps 1 through 6, then clean the contaminated
wells of the sample block using 10% bleach solution:

a. Pipette a small volume of 10% bleach solution into each contaminated well.

b. In each contaminated well, pipette the solution up and down several times to
rinse the well.

c. Pipette the bleach solution to a waste beaker.

IMPORTANT! Always use deionized water to rinse wells after cleaning with bleach
or ethanol solution.

Repeat steps 7 through 11 to rinse the wells of the sample block and to verify that
you have eliminated the contamination.

If the contamination remains, contact Applied Biosystems support (see “How to
Obtain Support” on page x).

Ensure that the heated cover door is completely closed and latched. If it is not, the
7500 software displays an error message.
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Replace the Halogen Lamp

Replace the halogen lamp after approximately 2000 hr of life.

I

AWARNING PHYSICAL INJURY HAZARD. The 7500/7500 Fast system and
lamp are hot! The lamp can become very hot while in use. Allow the lamp to cool for
15 min and put on protective, powder-free gloves before handling it.

]

ACAUTION PHYSICAL INJURY HAZARD. Wear disposable, powder-free
gloves when handling the lamp to prevent burns and to prevent shortening the life of the
replacement lamp.

T

WWLGWTIN{e] WARNING. This instrument is designed for 12 V, 75 W halogen
lamps only.

Time Required 30 min

Materials
Required @ \ %

Halogen bulb  Screwdriver, Powder-free Safety
12V, 75 W) small gloves glasses

Replace the IMPORTANT! Wear powder-free gloves when you handle the lamp.
Lamp

1. Power off, then unplug the 7500/7500 Fast system. Allow the instrument to cool for
15 min.

2. Open the access door to the 7500/7500 Fast system:

a. Insert a thin screwdriver into the keyhole on the edge of the access door, then
push to unlatch the door.

b. Open the access door.

Notes
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3. Remove the lamp from the instrument:
a. Slide the lamp release lever downward.

b. Firmly grasp the lamp and lift it up and out of the slotted mount.

IMPORTANT! Do not touch the lamp without powder-free gloves. Finger prints
shorten the lamp life.

4. Inspect the lamp for signs of failure (carbon typically coats the inside of failed
lamps).

Good bulb

Failed bulb
Replace

5. Install the new lamp into the instrument:
a. Slide the lamp release lever upward.

b. Firmly grasp the lamp, place it into the slotted mount, then carefully slide the
lamp downward into place.

Notes
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6. Close the access door.

7. Plug in and power on the 7500/7500 Fast system.

8. Open the ROI Inspector dialog box:

a. Inthe 7500 software, select Instrument » Instrument Maintenance
Manager.

b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

9. In the ROI Inspector dialog box, select Lamp Control » Idle.

10. While the instrument is running, look through grating of the access door and verify
that the lamp is illuminated, then click Done.

Light should be
visible

11. Ifthe lamp is illuminated, select Instrument » Lamp Status/Replacement in the 7500
software, click Reset Lamp Timer, then click OK.

If the lamp is not illuminated, the replacement halogen lamp may be defective.
Replace the lamp again. If the second lamp does not illuminate, check the
instrument fuses for failure (see page 66).

12. Perform the following calibrations after replacing the lamp. See:
* Chapter 2, Perform the Regions of Interest (ROI) Calibration
» Chapter 3, Perform the Background Calibration and Optical Calibration
* Chapter 4, Perform the Dye Calibration
* Chapter 5, Verify the Instrument Performance

Notes
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Replace the Instrument Fuses

Replace the Instrument Fuses

Replace the 7500/7500 Fast instrument fuses when the fuses fail.

ACAUTION FIRE HAZARD. For continued protection against the risk of fire,

replace fuses only with listed and certified fuses of the same type and rating as those
currently in the instrument.

Time Required 30 min

Materials
Required
Sy <
1 QF;-: stz(g())’ vy Flathead Powder-free Safety
5x 20 mm  Screwdriver gloves glasses

Replace the 1. Power off the instrument, then unplug it.

Fuses
2. Using a flat-head screwdriver, unscrew and remove the fuse holders from the

instrument.

3. Remove each fuse from its fuse holder and inspect it for damage. Carbon typically
coats the inside of failed fuses.

Iﬁ’ Good fuse
QW
g Failed fuse
/’ ; Replace
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4.

5.

6.

Chapter 6 User-Performed Maintenance n
Update the Windows Operating System

Replace each failed fuse with a 12.5 A, 250 V, 5 x 20-mm fuse.

Note: The voltage and amperage ratings are on the fuse holder.

Install the fuse holder.

Plug in, then power on the instrument.

The installation is successful if the instrument powers on.

Note: Fuse failure can result from fluctuations in the supplied power to the instrument.
To prevent further failures, consider installing an electrical protective device, such as a
UPS or other surge protector. For more information about fuses, see the 7500/7500 Fast
Site Preparation Guide.

Update the Windows Operating System

Determine
Compatibility of
an Upgrade or
Update

Notes

Do not upgrade or update the Microsoft Windows® operating system of the computer
running the 7500 software without first consulting the software release notes or the
Applied Biosystems website. Future versions of the Windows" operating system and
updates to the operating system can conflict with the 7500 software.

1.

2.

Open D:\Applied Biosystems\7500 Software v2.0, double-click release-notes.html,
then read the 7500 Software Release Notes for the compatibility of interest.

If the release notes do not mention the compatibility, use an internet browser to visit
www.appliedbiosystems.com, then search the website for the compatibility of
interest.

If the website does not contain the information of interest, contact
Applied Biosystems (see “How to Obtain Support” on page x).
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Update the 7500 Software

Update the 7500 Software

If you want to update the 7500 software, prepare your computer by exporting the
application libraries and backing up your experiment files.

Visit the Applied You can obtain 7500 software updates directly from the service section of the
Biosystems  Applied Biosystems website. For the latest services and support information for the
Website 7500/7500 Fast instrument:

1. Go to https://www2.appliedbiosystems.com/support/software/

2. In the Software Downloads page, select the appropriate instrument from the
drop-down list.

3. In the Software Downloads page for your instrument, click Updates - Patches.
The website opens the page describing the latest software updates for the 7500 software.

Prepare for the Before updating the 7500 software:

Upgrade o
1. Back up the application libraries:

a. In the main menu of the 7500 software, select Tools » <desired library>.

b. When the library dialog box opens, select the element(s) that you want to
export, then click Export.

c. In the Export dialog box, click Save to archive the selected records.

d. Repeat steps la through 1c for the remaining libraries to archive them.

2. Back up all experiment files by creating a copy of the directory that you are using to
store files.

The default directory for experiments is:

D:\Applied Biosystems\7500\experiments

Notes
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Notes

Store, Move, and Install the
7500/7500 Fast System

This chapter covers:

B Store the 7500/7500 Fast System .. ...t 70
B Move the 7500/7500 Fast System. .. ...t 71
B Set Up the 7500/7500 Fast System . .. ...ttt 73

Note: For more information about any of the topics discussed in this guide, access the
Help from within Applied Biosystems 7500/7500 Fast Real-Time PCR System Software
v2.0 by pressing F1, clicking @ in the toolbar, or selecting Help » 7500 Software Help.
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Store the 7500/7500 Fast System

Store the 7500/7500 Fast System

Time Required

Materials
Required

Prepare the
Instrument

Notes

70

The Applied Biosystems 7500/7500 Fast Real-Time PCR System can be powered off and
stored for extended periods of time. The length of the period of inactivity determines the
method you use to power off the instrument.

5 min

ABI PrisM" Optical 96-Well Reaction Plate or Optical 96-Well Fast Plate (unused)

1. Open the instrument tray door.
2. Ifthe tray contains a plate, remove it.

3. Ifyou plan to store the 7500/7500 Fast instrument for more than a week or you plan
to move the instrument, load an unused plate into the tray.

Note: The empty plate protects the internal components of the 7500/7500 Fast
instrument during transport or during periods of inactivity lasting more than a week.

4. Push the tray door to move it into the instrument.

5. Press the instrument power button.

6. Power off the computer and monitor:
a. Select Start » Shut Down.
b. In the Shut Down Windows dialog box, select Shut Down.

c. Power off the monitor.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Appendix A Store, Move, and Install the 7500/7500 Fast System “
Move the 7500/7500 Fast System

Move the 7500/7500 Fast System

Perform this procedure to safely move the 7500/7500 Fast instrument short distances (for
example, between laboratories of the same building).

ACAUTION PHYSICAL INJURY HAZARD. Do not attempt to lift the

instrument or any other heavy objects unless you have received related training. Incorrect
lifting can cause painful and sometimes permanent back injury. Use proper lifting
techniques when lifting or moving the instrument. At least 2 people are required to lift
the 7500/7500 Fast system.

IMPORTANT! Moving your Applied Biosystems 7500/7500 Fast Real-Time PCR System
can create subtle changes in the alignment of the instrument optics.

Materials ABI PrisM” Optical 96-Well Reaction Plate and Optical 96-Well Fast Plate (unused)
Required

Prepare the 1. Load the empty reaction plate into the 7500/7500 Fast instrument.

Instrument ) )
2. Using the ROI Inspector, manually raise the sample block:

a. In the 7500 software, select Instrument » Instrument Maintenance
Manager.

b. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

c. In the ROI Inspector dialog box, click Block Up.
3. Power off the 7500/7500 Fast instrument and computer.
4. Disconnect all 7500/7500 Fast system components.

5. Move the 7500/7500 Fast system according to the
following guidelines:
* Verify that the surface on which you will place
the instrument can support at least 54.5 kg
(120 Ibs).
* Verify that the pathway to the final position of
the instrument is clear of obstructions.

» Keep your spine in a good neutral position.

* Bend at the knees and lift with your legs.

* Do not lift an object and twist your torso at the same time.

* Coordinate your intentions with your assistant before lifting and carrying.

Notes
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o Move the 7500/7500 Fast System

6. Reconnect the components of the 7500/7500 Fast system (see “Set Up the
7500/7500 Fast System” on page 73).

7. Run a TagMan®” RNase P Instrument Verification Plate (see page 45).

a. If the run passes, recalibrations are not necessary.

b. If the run fails, perform steps 8 through 12 to recalibrate the instrument.

RMase P Analysis Analysis Help @/
a Instructions: Review the results from the RMase P run. If the run failed, omit outliers, then click"Reanalyze." Repeat until the run passes. Click Finish to save
and applythe resulis
Status: Passed |£J| Reanalyze || Analysis Settings |
€| View Plate Layout T Results Tahle ]
E Analysis Amplification Plot | Standard Curve > Select Wells With | oot e v| | ‘

Plot Settings

Target Flot Color |Default v

Wiew Legend ‘

B [ el =

& by & i U oo |ufofo (o v |ofo|o

Standard Curve
geiwim|eieewiomism]m
30

I3 o o jvjojolvieioioioivio ]
s Ju [m |m [m (= = = == (= = s

27 - - 1 . -
S E R E ]
e e geisiwisimiois|smimims

Quantity

o jojulujulvleioioio oo
+ | A R A A A EN

Target: RNase P Slope: -3.502 Y-Inter: 40.933 Bz: 0.998 EM&: 93.012
wells: [[] 72 Unknown [5] 20 Standard [1] 4 Megative Control 0 Empty

CT

Legend
’- Standard . Unknown . Unknown (Flagged) %

[ cancel | | previous | [ next | | |

8. Perform an ROI calibration (see page 13).

9. Perform a background calibration (see page 23).
10. Perform an optical calibration (see page 25).
11. Perform a dye calibration (see page 32).

12. Perform an instrument verification run (see page 45).

Notes
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Set Up the 7500/7500 Fast System

Set Up the 7500/7500 Fast System

Set Up the Refer to the Applied Biosystems Real-Time System Computer Setup Guide for
Computer information on setting up a computer for use with the 7500/7500 Fast instrument.

Set Up the IMPORTANT! Do not connect the USB cable to the 7500/7500 Fast instrument until you are
7500/7500 Fast instructed to do so by this guide.
Instrument

Materials Required

* Phillips screwdriver (small and thin)

¢ Power cord

Set Up the 7500/7500 Fast System

1. Prepare the installation site as described in the Applied Biosystems 7500/7500 Fast
Real-Time PCR System Site Preparation Guide.

2. Open the access door to the 7500/7500 Fast instrument.

a. Insert a thin screwdriver into the keyhole on the edge of the access door, then
push to unlatch the door.

b. Open the access door.

3. Verify that the heated cover assembly is pulled fully toward the front of the
instrument. If the 7500/7500 Fast system has a heated cover latch installed, check
that the latch is in a locked position.

4. Inspect the instrument for damage caused by the transportation of the 7500/7500
Fast system.

If the instrument is damaged, record the location and appearance of the damage,
then contact Applied Biosystems technical support or your service representative for
assistance.

5. Close the access door.

6. Connect the power cord to the 7500/7500 Fast instrument, then to the wall
receptacle.

Note: Power cords for different voltages are provided in the packing kit. Connect
the cord with the receptacle appropriate for your voltage, then discard the remaining
power cords.

7. Press the power button at the lower right front panel, then wait for the 7500/7500
Fast instrument to start up (about 30 sec).

Notes
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Set Up the 7500/7500 Fast System

Notes
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11.

12.

When the Power status light on the lower left front panel is lit, push the tray door to
open it.

Remove the packaging plate from the tray and set it aside.

. Close the tray door, then press the power button again to power off the instrument.

Note: Install any additional hardware.

IMPORTANT! Do not connect the USB cable to the 7500/7500 Fast instrument at
this time.

Verify that the 7500 software is installed to the computer.

If the computer does not have the 7500 software, use the Applied Biosystems 7500/7500
Fast Real-Time PCR System Software v2.0 Software CD to install the software.

Once you verify that the computer contains the 7500 software, connect the USB
cable to the 7500/7500 Fast instrument.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Appendix B

Create a Custom Dye Plate

The Applied Biosystems 7500/7500 Fast Real-Time PCR System can be used to run
assays designed with custom dyes (dyes not manufactured by Applied Biosystems).
Custom dyes must fluoresce within the 520 to 650 nm spectral range measured by the
7500/7500 Fast instrument.

Before Using Before using custom dyes with the 7500/7500 Fast instrument, you must:

Custom Dyes * Determine optimum dye concentration

» Create a custom dye plate
* Add the custom dye to the software
* Perform a dye calibration (see Chapter 4, “Perform the Dye Calibration.”)

Materials Pipettors and .
i pipette tips Water, ubes Safety
Required (200-pL and 1000-pL) deionized (2-mL and 10-mL) glasses

Custom
O

2wy, ==
= i

ABI PRrISM® Optical 96-Well Optical Adhesive Cover Powder-free
Reaction Plate and Optical or Optical Flat Caps gloves
96-Well Fast Plate

< Joereimo
Centrifuge with plate adapter

Notes
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Determine IMPORTANT! Wear powder-free gloves while creating the dye plate.
Optimum Dye
Concentration

1. In the center wells of a 96-well plate, prepare a dilution series of the custom dye (for
example, 25, 50, 100, 200, 400, 800, 1600, and 3200 nM) using 50-uL volumes for
the 7500 system or 20-uL volumes for the 7500 Fast system.

0102030409 06807o858,105115125

30000 T000CT0, 25 50 100 200
EGODODODODOOOOOOOOOOOOODOO

:000 0000000, OO OO
0000000000000, ) )
EOOOOOOOOOOOO

000000000000, Q O O O
000000000000,

000000000000 400 800 16003200

2. Seal the wells of the reaction plate using an optical adhesive cover.

3. Load the prepared reaction plate:
a. Push the tray door to open it.

b. Load the dye plate into the plate holder.

c. Push the tray door to close it.

4. In the 7500 software, select Instrument » Instrument Maintenance Manager.

5. In the ROI tab of the Instrument Maintenance Manager, click Start Manual
Calibration.

6. In the ROI Inspector, create the ROI image for each filter, beginning with Filter 1:
a. In the Exposure Time field, enter 1024.
b. Click Block Up.
c. Select Filter 1.
d. Click Snapshot.

Notes
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e. Inspect the image for saturation.

Normal Over

No Saturation Saturation Saturation

Acceptable Not Acceptable

f. Record the coordinate of the well that displays the brightest possible signal
without saturation. This well contains the optimal concentration of the custom
dye for Filter 1.

ROI Inspector '|

CCD Contral/Settings
Exposure Time [ms] 1024 ﬂ

Larnp Contral

\dle - Block Dawn

Capture Image From
Fiter: (& &

»

CC

]

L _iF

Pizel Intensity 138
Wells Found 96

Snapshot
Generate Calibration

Save Calibration

Filter Masks Loaded
A Ok
EB: 0K
C: 0K
D: 0K
E: 0K

Done

7. Repeat steps 6¢ through 6f for the remaining filters.

8. After you determine the optimum concentration for each filter, determine the
optimum concentration for the custom dye:

a. Compare the results from all filters.

b. Select the concentration that yields the highest possible signal in all filters, but
does not saturate.

Notes
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Unload the Plate ACAUTION PHYSICAL INJURY HAZARD. During instrument operation, the

Create a Custom
Dye Plate

Notes

78

sample block can be heated to 100 °C. Before performing the following procedure, be
sure to wait until the sample block reaches room temperature.

. In the ROI Inspector, click Block Down.

. Remove the plate from the instrument:

a. Push the tray door to open it.
b. Remove the plate.

c. Push the tray door to move it into the instrument.

Note: Ifyou cannot open the tray, the sample block may be in its raised position, locking
the tray position. To lower the block, click Move Down, then click Block Down.

3. Click Done.

IMPORTANT! Wear powder-free gloves while creating the dye plate.

. Prepare 5 mL (7500 system) or 2 mL (7500 Fast system) of the custom dye at the

concentration determined in step 8 on page 77.

. Pipette 50 puL (7500 system) or 20 puL (7500 Fast system) of the diluted custom dye

to all wells of an optical reaction plate.

. Seal the wells of the reaction plate using an optical adhesive cover.

4. Centrifuge the plate for 2 min at less than 1500 rpm.

IMPORTANT! The custom dye calibration plate must be well mixed and centrifuged.

Applied Biosystems 7500/7500 Fast Real-Time PCR System Maintenance Guide



Appendix B Create a Custom Dye Plate m

5. Verify that the liquid in each well of the ROI calibration plate is at the bottom of the
well. If not, centrifuge the plate again at a higher rpm and for a longer period of time.

Correct Incorrect
‘ Liquid is at ¢ Not centrifuged with enough force,
\ \  bottom of well. or

¢ Not centrifuged for enough time

Add the Custom 1. Inthe main screen of the 7500 software, select Instrument »
Dye to the Instrument Maintenance Manager.
Software

2. In the Instrument Maintenance Manager:
a. In the navigation pane, click Dye.
b. In the Dye screen, select Custom Dye Calibration.

c. Click Start Calibration.

3. In the Setup screen of the Dye Calibration dialog box, select a custom dye from the
list or create the custom dye as follows:

a. Click New Dye.
b. In the Dye Manager dialog box, click New.
c. Complete the New Dye dialog box, then click OK.

Field/Option Action
Name Enter a name for the custom dye.
| Wavelength | Enter the wavelength at which the dye fluoresces.
Type Select:

¢ Reporter if the dye works in conjunction with a quencher dye
to report an increase of PCR product.

¢ Quencher if the dye suppresses the fluorescence of a reporter
dye until amplification of PCR product.

¢ Both if the dye reports an increase of PCR product without the
aid of a quencher dye.

d. Click Close.

Notes
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Notes
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. In the Setup screen of the Dye Calibration dialog box, enter a temperature setting for

the calibration.

Note: Set the temperature to match the temperature at which you intend to collect
data. For example, the temperature for all Applied Biosystems system dyes is 60 °C
because data collection for TagMan® reagents occurs during the 60 °C extension
step of the PCR.

. Select The custom dye plate is loaded in the instrument, then click Next.

. In the Run screen, click Start Run, then wait for the 7500/7500 Fast instrument to

complete the dye calibration.

Note: Ifthe 7500 software displays messages during the run, troubleshoot the errors
as described in “Troubleshoot the Dye Calibration” on page 43.

. When the 7500/7500 Fast instrument displays the Main Menu, unload the custom

calibration plate.

. Analyze the custom spectral calibration as explained in “Analyze the Calibration

Data” on page 39.
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Create a Background Plate

Whenever possible, use a background plate that is included with the spectral calibration
kit. The plates supplied in the kit contain a buffer that accurately simulates the reagents
used for PCR, and, therefore, produces high-quality calibration data. However, if a
background plate from a spectral calibration kit is not available, you can create one as
described below.

Materials Pipettor, 200-pL Deionized
Required (with pipette tips) water Safety glasses

=

Applied Biosystems Optical Optical Adhesive Powder-free
96-Well Reaction Plate or Cover or Optical gloves
96-Well Fast Reaction Plate Flat Caps

Create a IMPORTANT! Wear powder-free gloves while creating the background plate.
Background Plate

1. Remove an Applied Biosystems 96-Well Optical Reaction Plate or 96-Well Fast
Reaction Plate from its box and place it on a clean, dry surface.

2. Aliquot 50 pL (7500 system) or 20 uL (7500 Fast system) of deionized water to each
well of the reaction plate.

3. Seal the plate using an optical adhesive cover or optical flat caps.

Use the plate for background calibration in the same way you use a background
plate from the spectral calibration kit. See Chapter 3, “Perform the Background
Calibration and Optical Calibration,”

Notes
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Notes
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chemical waste disposal xix
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H
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lamp replacement 63—65
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